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Overview

What's Metro shaped and has an ESP32-S2 WiFi module? What has a STEMMA QT
connector for I2C devices, and a Lipoly charger circuit? What's finishing up testing
and nearly ready for fabrication? That's right - its the new Adafruit Metro ESP32-S2!

With native USB and a load of PSRAM this board is perfect for use with CircuitPython
or Arduino, to add low-cost WiFi while keeping shield-compatibility.
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Features:
• ESP32-S2 240MHz Tensilica processor - the next generation of ESP32, now with
native USB so it can act like a keyboard/mouse, MIDI device, disk drive, etc!
• WROVER module has FCC/CE certification and comes with 4 MByte of Flash and
2 MByte of PSRAM - you can have huge data buffers
• Lotsa power options - 6-12VDC barrel jack or USB type C or Lipoly battery
• Built-in battery charging when powered over DC or USB
• UNO-shape so shields can plug in
• Reset and DFU (BOOT0) buttons to get into the ROM bootloader (which is a USB
serial port so you don't need a separate cable!)
• Serial debug pins (optional, for checking the hardware serial debug console)
• JTAG pads for advanced debugging access.
• On/Off switch
• STEMMA QT connector for I2C devices
• On/Charge/User LEDs + status NeoPixel
• Works with Arduino or CircuitPython
• 53.2mm x 72mm / 2" x 2.8"
• Height (w/ barrel jack): 14.8mm / 0.6"
• Weight: 22.5g
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Pinouts

The Metro ESP32-S2 is loaded with all kinds of features. There's lots of pins and
ports. Time to take a tour!
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PDF for Metro ESP32-S2 PrettyPins Diagram ()

Power

There's a lot of power options available on
the Metro ESP32-S2, and they're a little
different than most Metro/Arduinos

Power Inputs
You have three power input options:
• USB C port - This is used for both powering and programming the board. You
can power it with any USB C cable and will request 5V from a USB C PD.
When USB is plugged in it will charge the Lipoly battery. If there is no battery
attached, the yellow LED will flicker (it's looking for a battery!)
• DC barrel jack - The DC Jack is a 5.5mm/2.1mm center-positive DC connector,
which is the most common available. Provide about 6V-12V here to power the
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Metro. Great for when you have a wall adapter power supply. Don't use a centernegative adapter, it won't work (the OK green LED will not light)
When DC power is plugged in it will charge the Lipoly battery. If there is no
battery attached, the yellow LED will flicker (it's looking for a battery!)
If both DC and USB are plugged in, the metro will power itself & recharge the
battery from whichever is highest
• LiPoly connector/charger - You can plug in any 250mAh or larger 3.7/4.2V Lipoly
battery into this JST 2-PH port to both power your Metro and charge the battery.
The battery will charge from the USB or DC power (whichever is plugged in and
higher voltage), even if the board is powered off via the switch.
If the battery is plugged in and USB or DC is plugged in, the Metro will power
itself from USB or DC and it will charge the battery up.
When the battery is charging, the yellow CHG LED will be lit. When charging is
complete, the LED will turn off.

Power Control
• On/Off switch - This switch controls power to the board. If you plug in your
board and nothing happens, make sure the switch is flipped to "ON"!
When switched off it will disable the 3.3V power which turns off the ESP32S2
and NeoPixel, but it does not turn off the VHI or VIN pins (see below) and will
leave the battery charging.

Power Outputs
• 3.3V - This is the output pin from the 3.3V regulator, you can grab up to 400mA
from this regulator for accessories, it's also used by the ESP32S2 which can
have spiky current draw.
• VHI - This pin is usually marked 5V on Arduinos, and when USB or DC is
plugged in, it will in fact provide 5V. However, if you have the Metro on LiPo
battery power, it will be powered from the battery and thus between 3.7V to
4.2V
When powered from USB or DC it is regulated to 5V, when powered from
battery only, it's not regulated, but it is high-current, great for driving servos and
NeoPixels.
• GND - This is the common ground for all power and logic.
• VIN - This is the higher of the DC jack or USB voltage. So if the DC jack is
plugged in and 9V, VIN is 9V. If only USB connected, this will be 5V.
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ESP32-S2 WiFi Module
The ESP32-S2 WROVER module.
The ESP32-S2 is a highly-integrated, lowpower, 2.4 GHz Wi-Fi System-on-Chip
(SoC) solution that now has built-in native
USB as well as some other interesting new
technologies like Time of Flight distance
measurements. With its state-of-the-art
power and RF performance, this SoC is an
ideal choice for a wide variety of
application scenarios relating to the
Internet of Things (IoT) (), wearable
electronics (), and smart homes.

Please note, this is a single-core 240 MHz chip so it won't be as fast as ESP32's with
dual-core. Also, there is no Bluetooth support. However, we are super excited about
the ESP32-S2's native USB which unlocks a lot of capabilities for advanced
interfacing! This WROVER module comes with 4 MB flash and 2 MB PSRAM.
The 4 MB of flash is inside the module and is used for both program firmware and
filesystem storage. For example, in CircuitPython, we have 3 MB set aside for program
firmware (this includes two OTA option spots as well) and a 1MB section for
CircuitPython scripts and files.
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Logic Pins
These are the logic pins that can be used
to connect shields, sensors, servos, LEDs
and more!
No pins are shared, and no pins are
'special' bootstrapping pins, so you can
use any of them for input, or output, will
pullups or pulldowns, without worry.
ESP32 chips allow for 'multiplexing' of
almost all signals so it isn't like some pins
can do PWM and others can. You can
connect any of the available PWM
channels, I2S channels, UART, I2C or SPI
ports to any pin. There are some
exceptions....

Pin numbers next to pins are the ESP32 IO pin number. E.g. pin 5 is IO5 and 21 is
IO21. This is not true for pin names such as A0 thru A5 (these are IO17, IO18, IO1,
IO2, IO3, and IO4 in that order), SPI pins (SCK is IO36, MOSI IS IO35 and MISO is
IO37) or I2C pins (SDA is IO33 and SCL is IO34)
• A0 and A1 are the only DAC output pins. These can be used as 8-bit true analog
outputs. No other pins can do so.
• A0 thru A5, IO5 to IO16 - can also be analog inputs. The labeled SPI port, I2C
port and pins 21 and 42 cannot.
IO11 thru IO16 and A0 plus A1 are on ADC2
A2 thru A5 plus IO5 thru IO10 are on ADC1
Check the ESP32-S2 datasheet for the ADC channel names for each pin if you
need em!
• The 2x3 SPI pins on the right side of the board is on the ESP32 high speed SPI
peripheral - you can set any pins to be the low-speed peripheral but you won't
get the speedy interface!
• The SDA/SCL I2C pins have 3.3V pullups on them, and are shared with the
STEMMA QT port
• Pin 42 is connected to a red LED and is also shared with the JTAG TMS pin. If
you happen to be JTAG debugging, this pin will not be available to you.
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• Pin 45 is connected to the NeoPixel and is a special bootrstap pin but we only
use it as an output so it doesn't matter that there's a pullup/down on it.

LEDs and NeoPixel
NeoPixel LED - This addressable RGB
NeoPixel LED is both a status LED and
user controllable on IO45
LED - This red LED on IO42 is user
controllable for blinky needs, it is shared
with JTAG TMS and cannot be used if you
happen to be JTAG decoding.
OK LED - This green LED indicates the
board is powered on, it is connected to the
3.3V power supply.
CHG LED - This yellow LED lets you know
when the plugged in battery is charging
and when it's fully charged. It's normal for
this LED to flicker when no battery is in
place, that's the charge circuitry trying to
detect whether a battery is there or not.
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STEMMA QT
STEMMA QT () - This JST SH 4-pin
connector breaks out I2C (SCL, SDA, 3.3V,
GND). It allows you to connect to various
breakouts and sensors with STEMMA QT
connectors () or to other things
using assorted associated accessories ().
In CircuitPython, you can use the STEMMA
connector
with board.SCL and board.SDA ,
or board.STEMMA_I2C() .
Works great with any STEMMA QT or Qwiic
sensor/device
You can also use it with Grove I2C devices
thanks to this handy cable ()

UART Debug
The hardware UART debug port has two
broken out pins. You can connect these to
a USB console cable in order to read the
debug output from the ESP32 IDF (). This is
useful if you are writing software and need
to see the low level debug output without
using JTAG debugging.
This is not where default
Serial.print() or CircuitPython
print() outputs go, because those will
go through the USB port instead!
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Reset and DFU
Reset button - The reset button in the top
left corner is used to reset the board.
DFU button - This is connected to BOOT0
and can be used to put the board into
ROM bootloader mode. To enter ROM
bootloader mode, hold down DFU button
while clicking reset button mentioned
above. When in the ROM bootloader, you
can upload code and query the chip using
esptool

JTAG Debug
If you'd like to do more advanced
development, trace-debugging, or not use
the bootloader, we have the JTAG
interface exposed. You'll need to solder an
2x5 1.27mm pitch connector () or Mini 2x5
connector () to your board. A JLink or
similar is needed to perform debugging.

SEGGER J-Link EDU Mini - JTAG/SWD
Debugger
Doing some serious development on any
ARM-based platform, and tired of 'printf'
plus an LED to debug? A proper JTAG/
SWD HW debugger can make debugging
more of a pleasure and...
https://www.adafruit.com/product/3571
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ROM Bootloader
The ESP32-S2 has a built in bootloader, which means you never have to worry about
'bricking' your board. You can use it to load code directly, say CircuitPython or the
binary output of an Arduino compilation or you can use it to load a second bootloader
on, like UF2 which has a drag-n-drop interface.
The ROM bootloader can never be disabled or erased, so its always there if you need
it!

Enter ROM Bootloader Mode
Entering the bootloader is easy. Complete the following steps.

1. Make sure your ESP32-S2 is plugged
into USB port to your computer using
a data/sync cable. Charge-only
cables will not work!
2. Turn on the On/Off switch - check
that you see the OK light on so you
know the board is powered, a
prerequisite!
3. Press and hold the DFU / Boot0
button down. Don't let go of it yet!
4. Press and release the Reset button.
You should have the DFU/Boot0
button pressed while you do this.
5. Now you can release the DFU /
Boot0 button
6. Check your computer for a new serial
/ COM port. On windows check the
Device manager
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On Windows check the Device manager you will see a COM port, for example here
its COM88. You may also see another
"Other device" called ESP32-S2
It's best to do this with no other dev
boards plugged in so you don't get
confused about which COM port is the
ESP32-S2

On Mac/Linux you will need to find the tty
name which lives under /dev
On Linux, try ls /dev/ttyS* for example, to
find the matching serial port name. In this
case it shows up as /dev/ttyS87. If you
don't see it listed try ls /dev/ttyA* on some
Linux systems it might show up like /dev/
ttyACM0
On Mac, try ls /dev/cu.usbmodem* for
example, to find the matching serial port
name. In this case, it shows up as /dev/
cu.usbmodem01
It's best to do this with no other dev
boards plugged in so you don't get
confused about which serial port is the
ESP32-S2

Run esptool and check connection
Once you have entered ROM bootloader mode, you can then use Espressif's esptool
program () to communicate with the chip! esptool is the 'official' programming tool
and is the most common/complete way to program an ESP chip.
You will need to use the command line / Terminal to install and run esptool .
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You will also need to have pip and Python installed (any version!)
Install the latest version using pip (you may be able to run pip without the 3
depending on your setup):
pip3 install --upgrade esptool

Then, you can run:
esptool.py

Run esptool.py in a new terminal/command line and verify you get something like
the below:

Make sure you are running esptool v 3.0 or higher, which adds ESP32-S2 support
esptool v3.2 has a bug which prevents automatic chip detection. Add the
argument `--chip esp32-s2` to your commands if you are getting errors.
Run the following command, replacing the identifier after --port with the COMxx , /
dev/cu.usbmodemxx or /dev/ttySxx you found above.
esptool.py --port COM88 chip_id

You should get a notice that it connected over that port and found an ESP32-S2

You can now upload a binary file with the following command
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esptool.py --port COM88 --after=no_reset write_flash 0x0 firmware.bin

don't forget to change the --port name to match, and the file name from
firmware.bin to whatever the firmware file name is.
For example, I downloaded CircuitPython .bin and programmed it thus:

Once the data is verified, press the Reset button once more to launch the code you
just programmed in!

Web Serial ESPTool
The WebSerial ESPTool was designed to be a web-capable option for programming
Espressif ESP family microcontroller boards that have a serial based ROM bootloader.
It allows you to erase the contents of the microcontroller and program up to 4 files at
different offsets.
For boards that lack native USB, like the ESP32 or ESP32-C3 microcontroller, this is
how any firmware like CircuitPython .bin files can be loaded. There is no drag-anddrop to a folder option for these boards.
For boards with native USB, like ESP32-S2, -S3, etc. this is how the UF2 bootloader .bi
n file can be loaded. Once the UF2 bootloader is on, firmware like CircuitPython .uf2
files can be drag-and-dropped to a BOOT folder.
This tool is a good alternative for folks who cannot run Python esptool.py on their
computer or are having difficulty installing or using esptool.py
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Enabling Web Serial

You will have to use the Chrome or
Chromium-based browser for this to work.
For example, Edge and Opera are
Chromium (). Safari and Firefox, etc are not
supported - they have not implemented
Web Serial ()!

If you have a very old version of Chrome,
you'll need to enable the Serial API, which
is really easy.
Visit chrome://flags from within Chrome.
Find and enable the Experimental Web
Platform features

Restart Chrome

Connecting
Before you can use the tool, you will need to put your board in bootloader mode and
connect. Here are the steps:

In the Chrome browser visit https://
adafruit.github.io/
Adafruit_WebSerial_ESPTool/ (). You
should see something like the image
shown.
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For all ESP32-family boards, you can enter
the ROM bootloader by holding down the
BOOT button while clicking RST.
If you have an ESP32 board without BOOT
(say because its an original ESP32, not -S2
or -S3, etc) you can skip this step because
there's an auto-boot circuit.
Press the Connect button in the top right
of the web browser. You will get a pop up
asking you to select the COM or Serial
port. Look for something with ESP32, JTAG
Loader, SLAB, or FTDI in the name.
Remember, you should remove all other
USB devices so only the target board is
attached, that way there's no confusion
over multiple ports!
On some systems, such as MacOS, there
may be additional system ports that
appear in the list.

The Javascript code will now try to
connect to the ROM bootloader. It may
timeout for a bit until it succeeds. On
success, you will see that it
is Connected and will print out a
unique MAC address identifying the board
along with other information that was
detected.
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Once you have successfully connected,
the command toolbar will appear.

Erasing the Contents
If you would like to erase the entire flash area so that you can start with a clean slate,
you can use the erase feature. We recommend doing this if you are having issues.

To erase the contents, click the Erase
button. You will be prompted whether you
want to continue. Click OK to continue or if
you changed your mind, just click cancel.

You'll see "Erasing flash memory. Please
wait..." This will eventually be followed by
"Finished." and the amount of time it took
to erase.
Do not disconnect! Immediately continue
on to Programming the ESP
Microcontroller.
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Programming the ESP Microcontroller
You can click on Choose a file... from any
of the available buttons. It will only attempt
to program buttons with a file and a
unique location. Then select the .bin file(s)
- not the UF2 file!
Verify that the Offset box next to the file
location you used is 0x0.

Once you choose a file, the button text will
change to match your filename. You can
then select the Program button to start
flashing.

A progress bar will appear and after a
minute or two, you will have written the
firmware.

After using the tool, press the reset button to get out of bootloader mode and
launch the new firmware!
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For boards lacking native USB, like the ESP32 and ESP32-C3, no folder will show up
after pressing reset. If CircuitPython firmware was loaded, the REPL can be accessed
over a serial COM port.
For other boards, like ESP32-S2, -S3, etc., a BOOT folder should show up. A CircuitPyt
hon UF2 () file can now be copied over to the BOOT folder, after which the CIRCUITPY
folder should then show up.

Install UF2 Bootloader
If you're familiar with our other products and chipsets you may be famliar with our
drag-n-drop bootloader, a.k.a UF2. We have a UF2 bootloader for the ESP32-S2, that
will let you drag firmware on/off a USB disk drive
Unlike the M0 (SAMD21) and M4 (SAMD51) boards, there is no bootloader
protection for the UF2 bootloader. That means it is possible to erase or damage
the bootloader, especially if you upload Arduino sketches to ESP32S2 boards
that doesn't "know" there's a bootloader it should not overwrite!
However, thanks to the ROM bootloader, you don't have to worry about it if the UF2
bootloader is damaged. You can simply re-load the UF2 bootloader (USB-disk-style)
with the ROM bootloader (non-USB-drive)
Installing a new bootloader will erase your MagTag! Be sure to back up your data
first.

Step 1. Get into the ROM bootloader and install esptool.py
See the previous page on how to do that! ()

Step 2. Download the TinyUF2 release for your board
Choose the right release file from the list below. If your board is not explicitly
mentioned, find it in the "all boards" link. These links are to .zip files.

Latest MagTag TinyUF2 release
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Latest Metro ESP32-S2 TinyUF2
release
Latest Adafruit FunHouse TinyUF2
release
Look here if your board is not one of the ones above:

Latest TinyUF2 release for all
boards

Step 3. Extract the combined.bin file from TinyUF2
release
The file you downloaded in Step 2 is a .zip file. Unzip it and find the combined.bin file.
Note that this file is 3MB but that's because the bootloader is near the end of the
available flash. It's not actually 3MB of program: mostof the file is empty but it's easier
to program if we give you one combined 'swiss cheese' file. Save this file to your
desktop or wherever you plan to run esptool from.

Step 4. Option A) Use esptool.py to upload
• Put the board into bootloader mode (hold down BOOT0/DFU and click reset)
• Determine the serial or COM port of the board
Run this command and replace the serial port name with your matching port and the
file you just downloaded
esptool.py -p COM88 write_flash 0x0 combined.bin

There might be a bit of a 'wait' when programming, where it doesn't seem like its
working. Give it a minute, it has to erase the old flash code which can cause it to
seem like its not running.
You'll finally get an output like this:
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Click RESET button to launch the bootloader. You'll see a new disk drive on your
computer with the name MAGTAGBOOT or similar

Step 4 Option B) Use the Web Serial ESPTool to upload
Another option if you are having trouble getting ESPTool running, is to use the Web
Serial ESPTool () in this guide. This tool uses Web Serial to erase or upload firmware
to your board.

Welcome To CircuitPython
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So, you've got a new CircuitPython compatible board. You plugged it in. Maybe it
showed up as a disk drive called CIRCUITPY. Maybe it didn't! Either way, you need to
know where to go from here. Well, this guide has you covered!

This guide will get you started with CircuitPython!
There are many amazing things about your new board. One of them is the ability to
run CircuitPython. You may have seen that name on the Adafruit site () somewhere.
Not sure what it is? This guide can help!
"But I've never coded in my life. There's no way I do it!" You absolutely can!
CircuitPython is designed to help you learn from the ground up. If you're new to
everything, this is the place to start!
This guide will walk you through how to get started with CircuitPython. You'll learn
how to install CircuitPython, get updated to the newest version of CircuitPython,
setup a serial connection, and edit your code. You'll learn some basics of how
CircuitPython works, and about the CircuitPython libraries. You'll also find a list of
frequently asked questions, and a series of troubleshooting steps if you run into any
issues.
Welcome to CircuitPython!

Installing the Mu Editor
Mu is a simple code editor that works with the Adafruit CircuitPython boards. It's
written in Python and works on Windows, MacOS, Linux and Raspberry Pi. The serial
console is built right in so you get immediate feedback from your board's serial
output!
Mu is our recommended editor - please use it (unless you are an experienced
coder with a favorite editor already!).
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Download and Install Mu
Download Mu from https://codewith.mu ().
Click the Download link for downloads and
installation instructions.
Click Start Here to find a wealth of other
information, including extensive tutorials
and and how-to's.

Windows users: due to the nature of MSI installers, please remove old versions of
Mu before installing the latest version.
Ubuntu users: Mu currently (checked May 4, 2022) does not install properly on
Ubuntu 22.04. See https://github.com/mu-editor/mu/issues to track this issue.
See https://learn.adafruit.com/welcome-to-circuitpython/recommended-editors
and https://learn.adafruit.com/welcome-to-circuitpython/pycharm-andcircuitpython for other editors to use.

Starting Up Mu
The first time you start Mu, you will be
prompted to select your 'mode' - you can
always change your mind later. For now
please select CircuitPython!
The current mode is displayed in the lower
right corner of the window, next to the
"gear" icon. If the mode says "Microbit" or
something else, click the Mode button in
the upper left, and then choose
"CircuitPython" in the dialog box that
appears.
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Mu attempts to auto-detect your board on
startup, so if you do not have a
CircuitPython board plugged in with a
CIRCUITPY drive available, Mu will inform
you where it will store any code you save
until you plug in a board.
To avoid this warning, plug in a board and
ensure that the CIRCUITPY drive is
mounted before starting Mu.

Using Mu
You can now explore Mu! The three main sections of the window are labeled below;
the button bar, the text editor, and the serial console / REPL.

Now you're ready to code! Let's keep going...

Creating and Editing Code
One of the best things about CircuitPython is how simple it is to get code up and
running. This section covers how to create and edit your first CircuitPython program.
To create and edit code, all you'll need is an editor. There are many options. Adafruit
strongly recommends using Mu! It's designed for CircuitPython, and it's really simple
and easy to use, with a built in serial console!
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If you don't or can't use Mu, there are a number of other editors that work quite well.
The Recommended Editors page () has more details. Otherwise, make sure you do
"Eject" or "Safe Remove" on Windows or "sync" on Linux after writing a file if you
aren't using Mu. (This is not a problem on MacOS.)

Creating Code
Installing CircuitPython generates a
code.py file on your CIRCUITPY drive. To
begin your own program, open your editor,
and load the code.py file from the
CIRCUITPY drive.
If you are using Mu, click the Load button
in the button bar, navigate to the
CIRCUITPY drive, and choose code.py.

Copy and paste the following code into your editor:
import board
import digitalio
import time
led = digitalio.DigitalInOut(board.LED)
led.direction = digitalio.Direction.OUTPUT
while True:
led.value = True
time.sleep(0.5)
led.value = False
time.sleep(0.5)

The KB2040, QT Py and the Trinkeys do not have a built-in little red LED! There is
an addressable RGB NeoPixel LED. The above example will NOT work on the
KB2040, QT Py or the Trinkeys!
If you're using a KB2040, QT Py or a Trinkey, please download the NeoPixel blink
example ().
The NeoPixel blink example uses the onboard NeoPixel, but the time code is the
same. You can use the linked NeoPixel Blink example to follow along with this
guide page.
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It will look like this. Note that under the
while True: line, the next four lines
begin with four spaces to indent them, and
they're indented exactly the same amount.
All the lines before that have no spaces
before the text.

Save the code.py file on your CIRCUITPY
drive.

The little LED should now be blinking. Once per half-second.
Congratulations, you've just run your first CircuitPython program!
On most boards you'll find a tiny red LED.
On the ItsyBitsy nRF52840, you'll find a tiny blue LED.
On QT Py M0, QT Py RP2040, and the Trinkey series, you will find only an RGB
NeoPixel LED.

©Adafruit Industries

Page 32 of 141

Editing Code
To edit code, open the code.py file on your
CIRCUITPY drive into your editor.

Make the desired changes to your code.
Save the file. That's it!

Your code changes are run as soon as the file is done saving.
There's one warning before you continue...
Don't click reset or unplug your board!
The CircuitPython code on your board detects when the files are changed or written
and will automatically re-start your code. This makes coding very fast because you
save, and it re-runs. If you unplug or reset the board before your computer finishes
writing the file to your board, you can corrupt the drive. If this happens, you may lose
the code you've written, so it's important to backup your code to your computer
regularly.
There are a couple of ways to avoid filesystem corruption.

1. Use an editor that writes out the file completely when you save it.
Check out the Recommended Editors page () for details on different editing options.
If you are dragging a file from your host computer onto the CIRCUITPY drive, you
still need to do step 2. Eject or Sync (below) to make sure the file is completely
written.
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2. Eject or Sync the Drive After Writing
If you are using one of our not-recommended-editors, not all is lost! You can still make
it work.
On Windows, you can Eject or Safe Remove the CIRCUITPY drive. It won't actually
eject, but it will force the operating system to save your file to disk. On Linux, use the
sync command in a terminal to force the write to disk.
You also need to do this if you use Windows Explorer or a Linux graphical file
manager to drag a file onto CIRCUITPY.

Oh No I Did Something Wrong and Now The CIRCUITPY
Drive Doesn't Show Up!!!
Don't worry! Corrupting the drive isn't the end of the world (or your board!). If this
happens, follow the steps found on the Troubleshooting () page of every board
guide to get your board up and running again.

Back to Editing Code...
Now! Let's try editing the program you added to your board. Open your code.py file
into your editor. You'll make a simple change. Change the first 0.5 to 0.1 . The code
should look like this:
import board
import digitalio
import time
led = digitalio.DigitalInOut(board.LED)
led.direction = digitalio.Direction.OUTPUT
while True:
led.value = True
time.sleep(0.1)
led.value = False
time.sleep(0.5)

Leave the rest of the code as-is. Save your file. See what happens to the LED on your
board? Something changed! Do you know why?
You don't have to stop there! Let's keep going. Change the second 0.5 to 0.1 so it
looks like this:
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while True:
led.value = True
time.sleep(0.1)
led.value = False
time.sleep(0.1)

Now it blinks really fast! You decreased the both time that the code leaves the LED on
and off!
Now try increasing both of the 0.1 to 1 . Your LED will blink much more slowly
because you've increased the amount of time that the LED is turned on and off.
Well done! You're doing great! You're ready to start into new examples and edit them
to see what happens! These were simple changes, but major changes are done using
the same process. Make your desired change, save it, and get the results. That's
really all there is to it!

Naming Your Program File
CircuitPython looks for a code file on the board to run. There are four options: code.tx
t, code.py, main.txt and main.py. CircuitPython looks for those files, in that order, and
then runs the first one it finds. While code.py is the recommended name for your code
file, it is important to know that the other options exist. If your program doesn't seem
to be updating as you work, make sure you haven't created another code file that's
being read instead of the one you're working on.

Connecting to the Serial Console
One of the staples of CircuitPython (and programming in general!) is something called
a "print statement". This is a line you include in your code that causes your code to
output text. A print statement in CircuitPython (and Python) looks like this:
print("Hello, world!")

This line in your code.py would result in:
Hello, world!

However, these print statements need somewhere to display. That's where the serial
console comes in!
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The serial console receives output from your CircuitPython board sent over USB and
displays it so you can see it. This is necessary when you've included a print statement
in your code and you'd like to see what you printed. It is also helpful for
troubleshooting errors, because your board will send errors and the serial console will
display those too.
The serial console requires an editor that has a built in terminal, or a separate
terminal program. A terminal is a program that gives you a text-based interface to
perform various tasks.

Are you using Mu?
If so, good news! The serial console is built into Mu and will autodetect your board
making using the serial console really really easy.
First, make sure your CircuitPython board
is plugged in.
If you open Mu without a board plugged
in, you may encounter the error seen here,
letting you know no CircuitPython board
was found and indicating where your code
will be stored until you plug in a board.
If you are using Windows 7, make sure you
installed the drivers ().

Once you've opened Mu with your board plugged in, look for the Serial button in the
button bar and click it.

The Mu window will split in two, horizontally, and display the serial console at the
bottom.

©Adafruit Industries

Page 36 of 141

If nothing appears in the serial console, it may mean your code is done running
or has no print statements in it. Click into the serial console part of Mu, and press
CTRL+D to reload.

Serial Console Issues or Delays on Linux
If you're on Linux, and are seeing multi-second delays connecting to the serial
console, or are seeing "AT" and other gibberish when you connect, then the
modemmanager service might be interfering. Just remove it; it doesn't have much use
unless you're still using dial-up modems.
To remove modemmanager , type the following command at a shell:
sudo apt purge modemmanager

Setting Permissions on Linux
On Linux, if you see an error box something like the one below when you press the S
erial button, you need to add yourself to a user group to have permission to connect
to the serial console.

On Ubuntu and Debian, add yourself to the dialout group by doing:
sudo adduser $USER dialout
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After running the command above, reboot your machine to gain access to the group.
On other Linux distributions, the group you need may be different. See the Advanced
Serial Console on Linux () for details on how to add yourself to the right group.

Using Something Else?
If you're not using Mu to edit, are using or if for some reason you are not a fan of its
built in serial console, you can run the serial console from a separate program.
Windows requires you to download a terminal program. Check out the Advanced
Serial Console on Windows page for more details. ()
MacOS has Terminal built in, though there are other options available for download. C
heck the Advanced Serial Console on Mac page for more details. ()
Linux has a terminal program built in, though other options are available for
download. Check the Advanced Serial Console on Linux page for more details. ()
Once connected, you'll see something like the following.

Interacting with the Serial Console
Once you've successfully connected to the serial console, it's time to start using it.
The code you wrote earlier has no output to the serial console. So, you're going to
edit it to create some output.
Open your code.py file into your editor, and include a print statement. You can print
anything you like! Just include your phrase between the quotation marks inside the
parentheses. For example:
import board
import digitalio
import time
led = digitalio.DigitalInOut(board.LED)
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led.direction = digitalio.Direction.OUTPUT
while True:
print("Hello, CircuitPython!")
led.value = True
time.sleep(1)
led.value = False
time.sleep(1)

Save your file.
Now, let's go take a look at the window with our connection to the serial console.

Excellent! Our print statement is showing up in our console! Try changing the printed
text to something else.
import board
import digitalio
import time
led = digitalio.DigitalInOut(board.LED)
led.direction = digitalio.Direction.OUTPUT
while True:
print("Hello back to you!")
led.value = True
time.sleep(1)
led.value = False
time.sleep(1)

Keep your serial console window where you can see it. Save your file. You'll see what
the serial console displays when the board reboots. Then you'll see your new change!
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The Traceback (most recent call last): is telling you the last thing your board
was doing before you saved your file. This is normal behavior and will happen every
time the board resets. This is really handy for troubleshooting. Let's introduce an error
so you can see how it is used.
Delete the e at the end of True from the line led.value = True so that it says le
d.value = Tru
import board
import digitalio
import time
led = digitalio.DigitalInOut(board.LED)
led.direction = digitalio.Direction.OUTPUT
while True:
print("Hello back to you!")
led.value = Tru
time.sleep(1)
led.value = False
time.sleep(1)

Save your file. You will notice that your red LED will stop blinking, and you may have a
colored status LED blinking at you. This is because the code is no longer correct and
can no longer run properly. You need to fix it!
Usually when you run into errors, it's not because you introduced them on purpose.
You may have 200 lines of code, and have no idea where your error could be hiding.
This is where the serial console can help. Let's take a look!

The Traceback (most recent call last): is telling you that the last thing it was
able to run was line 10 in your code. The next line is your error: NameError: name
'Tru' is not defined . This error might not mean a lot to you, but combined with
knowing the issue is on line 10, it gives you a great place to start!
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Go back to your code, and take a look at line 10. Obviously, you know what the
problem is already. But if you didn't, you'd want to look at line 10 and see if you could
figure it out. If you're still unsure, try googling the error to get some help. In this case,
you know what to look for. You spelled True wrong. Fix the typo and save your file.

Nice job fixing the error! Your serial console is streaming and your red LED Is blinking
again.
The serial console will display any output generated by your code. Some sensors,
such as a humidity sensor or a thermistor, receive data and you can use print
statements to display that information. You can also use print statements for
troubleshooting, which is called "print debugging". Essentially, if your code isn't
working, and you want to know where it's failing, you can put print statements in
various places to see where it stops printing.
The serial console has many uses, and is an amazing tool overall for learning and
programming!

The REPL
The other feature of the serial connection is the Read-Evaluate-Print-Loop, or REPL.
The REPL allows you to enter individual lines of code and have them run immediately.
It's really handy if you're running into trouble with a particular program and can't
figure out why. It's interactive so it's great for testing new ideas.

©Adafruit Industries

Page 41 of 141

Entering the REPL
To use the REPL, you first need to be connected to the serial console. Once that
connection has been established, you'll want to press CTRL+C.
If there is code running, in this case code measuring distance, it will stop and you'll
see Press any key to enter the REPL. Use CTRL-D to reload. Follow those
instructions, and press any key on your keyboard.
The Traceback (most recent call last): is telling you the last thing your board
was doing before you pressed Ctrl + C and interrupted it. The KeyboardInterrupt
is you pressing CTRL+C. This information can be handy when troubleshooting, but for
now, don't worry about it. Just note that it is expected behavior.

If your code.py file is empty or does not contain a loop, it will show an empty output
and Code done running. . There is no information about what your board was
doing before you interrupted it because there is no code running.

If you have no code.py on your CIRCUITPY drive, you will enter the REPL immediately
after pressing CTRL+C. Again, there is no information about what your board was
doing before you interrupted it because there is no code running.
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Regardless, once you press a key you'll see a >>> prompt welcoming you to the
REPL!

If you have trouble getting to the >>> prompt, try pressing Ctrl + C a few more times.
The first thing you get from the REPL is information about your board.

This line tells you the version of CircuitPython you're using and when it was released.
Next, it gives you the type of board you're using and the type of microcontroller the
board uses. Each part of this may be different for your board depending on the
versions you're working with.
This is followed by the CircuitPython prompt.

Interacting with the REPL
From this prompt you can run all sorts of commands and code. The first thing you'll do
is run help() . This will tell you where to start exploring the REPL. To run code in the
REPL, type it in next to the REPL prompt.
Type help() next to the prompt in the REPL.

Then press enter. You should then see a message.
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First part of the message is another reference to the version of CircuitPython you're
using. Second, a URL for the CircuitPython related project guides. Then... wait. What's
this? To list built-in modules type `help("modules")`. Remember the
modules you learned about while going through creating code? That's exactly what
this is talking about! This is a perfect place to start. Let's take a look!
Type help("modules") into the REPL next to the prompt, and press enter.

This is a list of all the core modules built into CircuitPython, including board .
Remember, board contains all of the pins on the board that you can use in your
code. From the REPL, you are able to see that list!
Type import board into the REPL and press enter. It'll go to a new prompt. It might
look like nothing happened, but that's not the case! If you recall, the import
statement simply tells the code to expect to do something with that module. In this
case, it's telling the REPL that you plan to do something with that module.

Next, type dir(board) into the REPL and press enter.

This is a list of all of the pins on your board that are available for you to use in your
code. Each board's list will differ slightly depending on the number of pins available.
Do you see LED ? That's the pin you used to blink the red LED!
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The REPL can also be used to run code. Be aware that any code you enter into the
REPL isn't saved anywhere. If you're testing something new that you'd like to keep,
make sure you have it saved somewhere on your computer as well!
Every programmer in every programming language starts with a piece of code that
says, "Hello, World." You're going to say hello to something else. Type into the REPL:
print("Hello, CircuitPython!")

Then press enter.

That's all there is to running code in the REPL! Nice job!
You can write single lines of code that run stand-alone. You can also write entire
programs into the REPL to test them. Remember that nothing typed into the REPL is
saved.
There's a lot the REPL can do for you. It's great for testing new ideas if you want to
see if a few new lines of code will work. It's fantastic for troubleshooting code by
entering it one line at a time and finding out where it fails. It lets you see what
modules are available and explore those modules.
Try typing more into the REPL to see what happens!
Everything typed into the REPL is ephemeral. Once you reload the REPL or return
to the serial console, nothing you typed will be retained in any memory space. So
be sure to save any desired code you wrote somewhere else, or you'll lose it
when you leave the current REPL instance!

Returning to the Serial Console
When you're ready to leave the REPL and return to the serial console, simply press CT
RL+D. This will reload your board and reenter the serial console. You will restart the
program you had running before entering the REPL. In the console window, you'll see
any output from the program you had running. And if your program was affecting
anything visual on the board, you'll see that start up again as well.
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You can return to the REPL at any time!

CircuitPython Libraries
As CircuitPython development continues and there are new releases, Adafruit
will stop supporting older releases. Visit https://circuitpython.org/downloads to
download the latest version of CircuitPython for your board. You must download
the CircuitPython Library Bundle that matches your version of CircuitPython.
Please update CircuitPython and then visit https://circuitpython.org/libraries to
download the latest Library Bundle.
Each CircuitPython program you run needs to have a lot of information to work. The
reason CircuitPython is so simple to use is that most of that information is stored in
other files and works in the background. These files are called libraries. Some of them
are built into CircuitPython. Others are stored on your CIRCUITPY drive in a folder
called lib. Part of what makes CircuitPython so great is its ability to store code
separately from the firmware itself. Storing code separately from the firmware makes
it easier to update both the code you write and the libraries you depend.
Your board may ship with a lib folder already, it's in the base directory of the drive. If
not, simply create the folder yourself. When you first install CircuitPython, an empty lib
directory will be created for you.

CircuitPython libraries work in the same way as regular Python modules so the Python
docs () are an excellent reference for how it all should work. In Python terms, you can
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place our library files in the lib directory because it's part of the Python path by
default.
One downside of this approach of separate libraries is that they are not built in. To
use them, one needs to copy them to the CIRCUITPY drive before they can be used.
Fortunately, there is a library bundle.
The bundle and the library releases on GitHub also feature optimized versions of the
libraries with the .mpy file extension. These files take less space on the drive and
have a smaller memory footprint as they are loaded.
Due to the regular updates and space constraints, Adafruit does not ship boards with
the entire bundle. Therefore, you will need to load the libraries you need when you
begin working with your board. You can find example code in the guides for your
board that depends on external libraries.
Either way, as you start to explore CircuitPython, you'll want to know how to get
libraries on board.

The Adafruit Learn Guide Project Bundle
The quickest and easiest way to get going with a project from the Adafruit Learn
System is by utilising the Project Bundle. Most guides now have a Download Project
Bundle button available at the top of the full code example embed. This button
downloads all the necessary files, including images, etc., to get the guide project up
and running. Simply click, open the resulting zip, copy over the right files, and you're
good to go!
The first step is to find the Download Project Bundle button in the guide you're
working on.
The Download Project Bundle button is only available on full demo code
embedded from GitHub in a Learn guide. Code snippets will NOT have the
button available.
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When you copy the contents of the Project Bundle to your CIRCUITPY drive, it
will replace all the existing content! If you don't want to lose anything, ensure you
copy your current code to your computer before you copy over the new Project
Bundle content!
The Download Project Bundle button downloads a zip file. This zip contains a series
of directories, nested within which is the code.py, any applicable assets like images or
audio, and the lib/ folder containing all the necessary libraries. The following zip was
downloaded from the Piano in the Key of Lime guide.

The Piano in the Key of Lime guide was chosen as an example. That guide is
specific to Circuit Playground Express, and cannot be used on all boards. Do not
expect to download that exact bundle and have it work on your non-CPX
microcontroller.
When you open the zip, you'll find some nested directories. Navigate through them
until you find what you need. You'll eventually find a directory for your CircuitPython
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version (in this case, 7.x). In the version directory, you'll find the file and directory you
need: code.py and lib/. Once you find the content you need, you can copy it all over
to your CIRCUITPY drive, replacing any files already on the drive with the files from
the freshly downloaded zip.
In some cases, there will be other files such as audio or images in the same
directory as code.py and lib/. Make sure you include all the files when you copy
things over!
Once you copy over all the relevant files, the project should begin running! If you find
that the project is not running as expected, make sure you've copied ALL of the
project files onto your microcontroller board.
That's all there is to using the Project Bundle!

The Adafruit CircuitPython Library Bundle
Adafruit provides CircuitPython libraries for much of the hardware they provide,
including sensors, breakouts and more. To eliminate the need for searching for each
library individually, the libraries are available together in the Adafruit CircuitPython
Library Bundle. The bundle contains all the files needed to use each library.

Downloading the Adafruit CircuitPython Library Bundle
You can download the latest Adafruit CircuitPython Library Bundle release by clicking
the button below. The libraries are being constantly updated and improved, so you'll
always want to download the latest bundle.
Match up the bundle version with the version of CircuitPython you are running. For
example, you would download the 6.x library bundle if you're running any version of
CircuitPython 6, or the 7.x library bundle if you're running any version of CircuitPython
7, etc. If you mix libraries with major CircuitPython versions, you will get incompatible
mpy errors due to changes in library interfaces possible during major version
changes.

Click to visit circuitpython.org for the
latest Adafruit CircuitPython Library
Bundle
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Download the bundle version that matches your CircuitPython firmware version. If you
don't know the version, check the version info in boot_out.txt file on the CIRCUITPY
drive, or the initial prompt in the CircuitPython REPL. For example, if you're running
v7.0.0, download the 7.x library bundle.
There's also a py bundle which contains the uncompressed python files, you probably
don't want that unless you are doing advanced work on libraries.

The CircuitPython Community Library
Bundle
The CircuitPython Community Library Bundle is made up of libraries written and
provided by members of the CircuitPython community. These libraries are often
written when community members encountered hardware not supported in the
Adafruit Bundle, or to support a personal project. The authors all chose to submit
these libraries to the Community Bundle make them available to the community.
These libraries are maintained by their authors and are not supported by Adafruit. As
you would with any library, if you run into problems, feel free to file an issue on the
GitHub repo for the library. Bear in mind, though, that most of these libraries are
supported by a single person and you should be patient about receiving a response.
Remember, these folks are not paid by Adafruit, and are volunteering their personal
time when possible to provide support.

Downloading the CircuitPython Community Library Bundle
You can download the latest CircuitPython Community Library Bundle release by
clicking the button below. The libraries are being constantly updated and improved,
so you'll always want to download the latest bundle.

Click for the latest CircuitPython
Community Library Bundle release
The link takes you to the latest release of the CircuitPython Community Library
Bundle on GitHub. There are multiple versions of the bundle available. Download the
bundle version that matches your CircuitPython firmware version. If you don't know
the version, check the version info in boot_out.txt file on the CIRCUITPY drive, or the
initial prompt in the CircuitPython REPL. For example, if you're running v7.0.0,
download the 7.x library bundle.
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Understanding the Bundle
After downloading the zip, extract its contents. This is usually done by double clicking
on the zip. On Mac OSX, it places the file in the same directory as the zip.

Open the bundle folder. Inside you'll find two information files, and two folders. One
folder is the lib bundle, and the other folder is the examples bundle.

Now open the lib folder. When you open the folder, you'll see a large number of .mpy
files, and folders.

Example Files
All example files from each library are now included in the bundles in an examples
directory (as seen above), as well as an examples-only bundle. These are included for
two main reasons:
• Allow for quick testing of devices.
• Provide an example base of code, that is easily built upon for individualized
purposes.
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Copying Libraries to Your Board
First open the lib folder on your CIRCUITPY drive. Then, open the lib folder you
extracted from the downloaded zip. Inside you'll find a number of folders and .mpy
files. Find the library you'd like to use, and copy it to the lib folder on CIRCUITPY.
If the library is a directory with multiple .mpy files in it, be sure to copy the entire
folder to CIRCUITPY/lib.
This also applies to example files. Open the examples folder you extracted from the
downloaded zip, and copy the applicable file to your CIRCUITPY drive. Then, rename
it to code.py to run it.
If a library has multiple .mpy files contained in a folder, be sure to copy the entire
folder to CIRCUITPY/lib.

Understanding Which Libraries to Install
You now know how to load libraries on to your CircuitPython-compatible
microcontroller board. You may now be wondering, how do you know which libraries
you need to install? Unfortunately, it's not always straightforward. Fortunately, there is
an obvious place to start, and a relatively simple way to figure out the rest. First up:
the best place to start.
When you look at most CircuitPython examples, you'll see they begin with one or
more import statements. These typically look like the following:
• import library_or_module
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However, import statements can also sometimes look like the following:
• from library_or_module import name
• from library_or_module.subpackage import name
• from library_or_module import name as local_name
They can also have more complicated formats, such as including a try / except
block, etc.
The important thing to know is that an import statement will always include the
name of the module or library that you're importing.
Therefore, the best place to start is by reading through the import statements.
Here is an example import list for you to work with in this section. There is no setup or
other code shown here, as the purpose of this section involves only the import list.
import time
import board
import neopixel
import adafruit_lis3dh
import usb_hid
from adafruit_hid.consumer_control import ConsumerControl
from adafruit_hid.consumer_control_code import ConsumerControlCode

Keep in mind, not all imported items are libraries. Some of them are almost always
built-in CircuitPython modules. How do you know the difference? Time to visit the
REPL.
In the Interacting with the REPL section () on The REPL page () in this guide, the
help("modules") command is discussed. This command provides a list of all of the
built-in modules available in CircuitPython for your board. So, if you connect to the
serial console on your board, and enter the REPL, you can run help("modules") to
see what modules are available for your board. Then, as you read through the impor
t statements, you can, for the purposes of figuring out which libraries to load, ignore
the statement that import modules.
The following is the list of modules built into CircuitPython for the Feather RP2040.
Your list may look similar or be anything down to a significant subset of this list for
smaller boards.
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Now that you know what you're looking for, it's time to read through the import
statements. The first two, time and board , are on the modules list above, so they're
built-in.
The next one, neopixel , is not on the module list. That means it's your first library!
So, you would head over to the bundle zip you downloaded, and search for neopixel.
There is a neopixel.mpy file in the bundle zip. Copy it over to the lib folder on your CI
RCUITPY drive. The following one, adafruit_lis3dh , is also not on the module list.
Follow the same process for adafruit_lis3dh, where you'll find adafruit_lis3dh.mpy,
and copy that over.
The fifth one is usb_hid , and it is in the modules list, so it is built in. Often all of the
built-in modules come first in the import list, but sometimes they don't! Don't assume
that everything after the first library is also a library, and verify each import with the
modules list to be sure. Otherwise, you'll search the bundle and come up empty!
The final two imports are not as clear. Remember, when import statements are
formatted like this, the first thing after the from is the library name. In this case, the
library name is adafruit_hid . A search of the bundle will find an adafruit_hid folder.
When a library is a folder, you must copy the entire folder and its contents as it is in
the bundle to the lib folder on your CIRCUITPY drive. In this case, you would copy the
entire adafruit_hid folder to your CIRCUITPY/lib folder.
Notice that there are two imports that begin with adafruit_hid . Sometimes you will
need to import more than one thing from the same library. Regardless of how many
times you import the same library, you only need to load the library by copying over
the adafruit_hid folder once.
That is how you can use your example code to figure out what libraries to load on
your CircuitPython-compatible board!
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There are cases, however, where libraries require other libraries internally. The
internally required library is called a dependency. In the event of library
dependencies, the easiest way to figure out what other libraries are required is to
connect to the serial console and follow along with the ImportError printed there.
The following is a very simple example of an ImportError , but the concept is the
same for any missing library.

Example: ImportError Due to Missing
Library
If you choose to load libraries as you need them, or you're starting fresh with an
existing example, you may end up with code that tries to use a library you haven't yet
loaded. This section will demonstrate what happens when you try to utilise a library
that you don't have loaded on your board, and cover the steps required to resolve the
issue.
This demonstration will only return an error if you do not have the required library
loaded into the lib folder on your CIRCUITPY drive.
Let's use a modified version of the Blink example.
import board
import time
import simpleio
led = simpleio.DigitalOut(board.LED)
while True:
led.value = True
time.sleep(0.5)
led.value = False
time.sleep(0.5)

Save this file. Nothing happens to your board. Let's check the serial console to see
what's going on.
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You have an ImportError . It says there is no module named 'simpleio' . That's
the one you just included in your code!
Click the link above to download the correct bundle. Extract the lib folder from the
downloaded bundle file. Scroll down to find simpleio.mpy. This is the library file you're
looking for! Follow the steps above to load an individual library file.
The LED starts blinking again! Let's check the serial console.

No errors! Excellent. You've successfully resolved an ImportError !
If you run into this error in the future, follow along with the steps above and choose
the library that matches the one you're missing.

Library Install on Non-Express Boards
If you have an M0 non-Express board such as Trinket M0, Gemma M0, QT Py M0, or
one of the M0 Trinkeys, you'll want to follow the same steps in the example above to
install libraries as you need them. Remember, you don't need to wait for an ImportEr
ror if you know what library you added to your code. Open the library bundle you
downloaded, find the library you need, and drag it to the lib folder on your CIRCUITPY
drive.
You can still end up running out of space on your M0 non-Express board even if you
only load libraries as you need them. There are a number of steps you can use to try
to resolve this issue. You'll find suggestions on the Troubleshooting page ().

Updating CircuitPython Libraries and
Examples
Libraries and examples are updated from time to time, and it's important to update the
files you have on your CIRCUITPY drive.
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To update a single library or example, follow the same steps above. When you drag
the library file to your lib folder, it will ask if you want to replace it. Say yes. That's it!
A new library bundle is released every time there's an update to a library. Updates
include things like bug fixes and new features. It's important to check in every so
often to see if the libraries you're using have been updated.

CircUp CLI Tool
There is a command line interface (CLI) utility called CircUp () that can be used to
easily install and update libraries on your device. Follow the directions on the install
page within the CircUp learn guide (). Once you've got it installed you run the
command circup update in a terminal to interactively update all libraries on the
connected CircuitPython device. See the usage page in the CircUp guide () for a full
list of functionality

Advanced Serial Console on Windows
Windows 7 and 8.1
If you're using Windows 7 (or 8 or 8.1), you'll need to install drivers. See the Windows 7
and 8.1 Drivers page () for details. You will not need to install drivers on Mac, Linux or
Windows 10.
You are strongly encouraged to upgrade to Windows 10 if you are still using Windows
7 or Windows 8 or 8.1. Windows 7 has reached end-of-life and no longer receives
security updates. A free upgrade to Windows 10 is still available ().

What's the COM?
First, you'll want to find out which serial port your board is using. When you plug your
board in to USB on your computer, it connects to a serial port. The port is like a door
through which your board can communicate with your computer using USB.
You'll use Windows Device Manager to determine which port the board is using. The
easiest way to determine which port the board is using is to first check without the
board plugged in. Open Device Manager. Click on Ports (COM & LPT). You should find
something already in that list with (COM#) after it where # is a number.
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Now plug in your board. The Device Manager list will refresh and a new item will
appear under Ports (COM & LPT). You'll find a different (COM#) after this item in the
list.

Sometimes the item will refer to the name of the board. Other times it may be called
something like USB Serial Device, as seen in the image above. Either way, there is a
new (COM#) following the name. This is the port your board is using.
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Install Putty
If you're using Windows, you'll need to download a terminal program. You're going to
use PuTTY.
The first thing to do is download the latest version of PuTTY (). You'll want to
download the Windows installer file. It is most likely that you'll need the 64-bit version.
Download the file and install the program on your machine. If you run into issues, you
can try downloading the 32-bit version instead. However, the 64-bit version will work
on most PCs.
Now you need to open PuTTY.
• Under Connection type: choose the button next to Serial.
• In the box under Serial line, enter the serial port you found that your board is
using.
• In the box under Speed, enter 115200. This called the baud rate, which is the
speed in bits per second that data is sent over the serial connection. For boards
with built in USB it doesn't matter so much but for ESP8266 and other board
with a separate chip, the speed required by the board is 115200 bits per second.
So you might as well just use 115200!
If you want to save those settings for later, use the options under Load, save or delete
a stored session. Enter a name in the box under Saved Sessions, and click the Save
button on the right.
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Once your settings are entered, you're ready to connect to the serial console. Click
"Open" at the bottom of the window. A new window will open.

If no code is running, the window will either be blank or will look like the window
above. Now you're ready to see the results of your code.
Great job! You've connected to the serial console!
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Advanced Serial Console on Mac
Connecting to the serial console on Mac does not require installing any drivers or
extra software. You'll use a terminal program to find your board, and screen to
connect to it. Terminal and screen both come installed by default.

What's the Port?
First you'll want to find out which serial port your board is using. When you plug your
board in to USB on your computer, it connects to a serial port. The port is like a door
through which your board can communicate with your computer using USB.
The easiest way to determine which port the board is using is to first check without
the board plugged in. Open Terminal and type the following:
ls /dev/tty.*

Each serial connection shows up in the /dev/ directory. It has a name that starts with
tty. . The command ls shows you a list of items in a directory. You can use * as a
wildcard, to search for files that start with the same letters but end in something
different. In this case, you're asking to see all of the listings in /dev/ that start with t
ty. and end in anything. This will show us the current serial connections.

Now, plug your board. In Terminal, type:
ls /dev/tty.*

This will show you the current serial connections, which will now include your board.
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A new listing has appeared called /dev/tty.usbmodem141441 . The tty.usbmodem1
41441 part of this listing is the name the example board is using. Yours will be called
something similar.
Using Linux, a new listing has appeared called /dev/ttyACM0 . The ttyACM0 part of
this listing is the name the example board is using. Yours will be called something
similar.

Connect with screen
Now that you know the name your board is using, you're ready connect to the serial
console. You're going to use a command called screen . The screen command is
included with MacOS. To connect to the serial console, use Terminal. Type the
following command, replacing board_name with the name you found your board is
using:
screen /dev/tty.board_name 115200

The first part of this establishes using the screen command. The second part tells
screen the name of the board you're trying to use. The third part tells screen what
baud rate to use for the serial connection. The baud rate is the speed in bits per
second that data is sent over the serial connection. In this case, the speed required
by the board is 115200 bits per second.
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Press enter to run the command. It will open in the same window. If no code is
running, the window will be blank. Otherwise, you'll see the output of your code.
Great job! You've connected to the serial console!

Frequently Asked Questions
These are some of the common questions regarding CircuitPython and CircuitPython
microcontrollers.

What are some common acronyms to know?
CP or CPy = CircuitPython ()
CPC = Circuit Playground Classic () (does not run CircuitPython)
CPX = Circuit Playground Express ()
CPB = Circuit Playground Bluefruit ()

Using Older Versions
As CircuitPython development continues and there are new releases, Adafruit
will stop supporting older releases. Visit https://circuitpython.org/downloads to
download the latest version of CircuitPython for your board. You must download
the CircuitPython Library Bundle that matches your version of CircuitPython.
Please update CircuitPython and then visit https://circuitpython.org/libraries to
download the latest Library Bundle.
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I have to continue using CircuitPython 6.x or earlier.
Where can I find compatible libraries?
We are no longer building or supporting the CircuitPython 6.x or earlier library
bundles. We highly encourage you to update CircuitPython to the latest version ()
and use the current version of the libraries (). However, if for some reason you
cannot update, here are the last available library bundles for older versions:
• 2.x bundle ()
• 3.x bundle ()
• 4.x bundle ()
• 5.x bundle ()
• 6.x bundle ()

Python Arithmetic
Does CircuitPython support floating-point numbers?
All CircuitPython boards support floating point arithmetic, even if the
microcontroller chip does not support floating point in hardware. Floating point
numbers are stored in 30 bits, with an 8-bit exponent and a 22-bit mantissa. Note
that this is two bits less than standard 32-bit single-precision floats. You will get
about 5-1/2 digits of decimal precision.
(The broadcom port may provide 64-bit floats in some cases.)

Does CircuitPython support long integers, like regular
Python?
Python long integers (integers of arbitrary size) are available on most builds, except
those on boards with the smallest available firmware size. On these boards,
integers are stored in 31 bits.
Boards without long integer support are mostly SAMD21 ("M0") boards without an
external flash chip, such as the Adafruit Gemma M0, Trinket M0, QT Py M0, and the
Trinkey series. There are also a number of third-party boards in this category.
There are also a few small STM third-party boards without long integer support.
time.localtime() , time.mktime() , time.time() , and
time.monotonic_ns() are available only on builds with long integers.
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Wireless Connectivity
How do I connect to the Internet with CircuitPython?
If you'd like to include WiFi in your project, your best bet is to use a board that is
running natively on ESP32 chipsets - those have WiFi built in!
If your development board has an SPI port and at least 4 additional pins, you can
check out this guide () on using AirLift with CircuitPython - extra wiring is required
and some boards like the MacroPad or NeoTrellis do not have enough available
pins to add the hardware support.
For further project examples, and guides about using AirLift with specific hardware,
check out the Adafruit Learn System ().

How do I do BLE (Bluetooth Low Energy) with
CircuitPython?
The nRF52840 and nRF52833 boards have the most complete BLE
implementation. Your program can act as both a BLE central and peripheral. As a
central, you can scan for advertisements, and connect to an advertising board. As a
peripheral, you can advertise, and you can create services available to a central.
Pairing and bonding are supported.
ESP32-C3 and ESP32-S3 boards currently provide an incomplete () BLE
implementation. Your program can act as a central, and connect to a peripheral.
You can advertise, but you cannot create services. You cannot advertise
anonymously. Pairing and bonding are not supported.
The ESP32 could provide a similar implementation, but it is not yet available. Note
that the ESP32-S2 does not have Bluetooth capability.
On most other boards with adequate firmware space, BLE is available for use with
AirLift () or other NINA-FW-based co-processors. Some boards have this
coprocessor on board, such as the PyPortal (). Currently, this implementation only
supports acting as a BLE peripheral. Scanning and connecting as a central are not
yet implemented. Bonding and pairing are not supported.
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Are there other ways to communicate by radio with
CircuitPython?
Check out Adafruit's RFM boards ()for simple radio communication supported by
CircuitPython, which can be used over distances of 100m to over a km, depending
on the version. The RFM SAMD21 M0 boards can be used, but they were not
designed for CircuitPython, and have limited RAM and flash space; using the RFM
breakouts or FeatherWings with more capable boards will be easier.

Asyncio and Interrupts
Is there asyncio support in CircuitPython?
There is support for asyncio starting with CircuitPython 7.1.0, on all boards except
the smallest SAMD21 builds. Read about using it in the Cooperative Multitasking in
CircuitPython () Guide.

Does CircuitPython support interrupts?
No. CircuitPython does not currently support interrupts - please use asyncio for
multitasking / 'threaded' control of your code

Status RGB LED
My RGB NeoPixel/DotStar LED is blinking funny colors what does it mean?
The status LED can tell you what's going on with your CircuitPython board. Read
more here for what the colors mean! ()

Memory Issues
What is a MemoryError?
Memory allocation errors happen when you're trying to store too much on the
board. The CircuitPython microcontroller boards have a limited amount of memory
available. You can have about 250 lines of code on the M0 Express boards. If you
try to import too many libraries, a combination of large libraries, or run a program
with too many lines of code, your code will fail to run and you will receive a
MemoryError in the serial console.
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What do I do when I encounter a MemoryError?
Try resetting your board. Each time you reset the board, it reallocates the memory.
While this is unlikely to resolve your issue, it's a simple step and is worth trying.
Make sure you are using .mpy versions of libraries. All of the CircuitPython libraries
are available in the bundle in a .mpy format which takes up less memory than .py
format. Be sure that you're using the latest library bundle () for your version of
CircuitPython.
If that does not resolve your issue, try shortening your code. Shorten comments,
remove extraneous or unneeded code, or any other clean up you can do to
shorten your code. If you're using a lot of functions, you could try moving those
into a separate library, creating a .mpy of that library, and importing it into your
code.
You can turn your entire file into a .mpy and import that into code.py. This means
you will be unable to edit your code live on the board, but it can save you space.

Can the order of my import statements affect memory?
It can because the memory gets fragmented differently depending on allocation
order and the size of objects. Loading .mpy files uses less memory so its
recommended to do that for files you aren't editing.

How can I create my own .mpy files?
You can make your own .mpy versions of files with mpy-cross .
You can download mpy-cross for your operating system from here (). Builds are
available for Windows, macOS, x64 Linux, and Raspberry Pi Linux. Choose the
latest mpy-cross whose version matches the version of CircuitPython you are
using.
To make a .mpy file, run ./mpy-cross path/to/yourfile.py to create a
yourfile.mpy in the same directory as the original file.

How do I check how much memory I have free?
Run the following to see the number of bytes available for use:
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import gc
gc.mem_free()

Unsupported Hardware
Is ESP8266 or ESP32 supported in CircuitPython? Why
not?
We dropped ESP8266 support as of 4.x - For more information please read about it
here ()!
As of CircuitPython 8.x we have started to support ESP32 and ESP32-C3 and have
added a WiFi workflow for wireless coding! ()
We also support ESP32-S2 & ESP32-S3, which have native USB.

Does Feather M0 support WINC1500?
No, WINC1500 will not fit into the M0 flash space.

Can AVRs such as ATmega328 or ATmega2560 run
CircuitPython?
No.

ESP32-S2 Bugs & Limitations
Nobody likes bugs, but all nontrivial software and hardware has some. The master list
of problems is the Issues list on github ().
Adafruit considers CircuitPython for the ESP32-S2 to be beta quality software.

I2C at 100 kHz bus frequency runs slowly
The default I2C bus clock speed is 100 kHz (100000) . At that rate, the ESP32-S2
will leave 10ms () gaps between I2C transactions. This can slow down your I2C
interactions considerably, such as when you are controlling a stepper motor with a
PCA9685 controller.
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Raising the I2C bus frequency to 125 kHz (125000) or higher fixes this problem. If
your I2C peripheral can handle higher frequencies, you can use 400 kHz (400000)
or even in some cases 1 MHz (1000000).
Note that board.I2C() creates an I2C bus that runs at 100 kHz. The bus
frequency cannot be changed.. To create an I2C bus on the default I2C pins that
runs at a different frequency, you must use busio.I2C(board.SCL, board.SDA,
frequency=) .

No DAC-based audio output
Current versions of the ESP-IDF SDK do not have the required APIs for DAC-based
audio output. Once a future version of ESP-IDF that adds it, it will be possible to
implement DAC-based AudioOut in CircuitPython.
Workaround: PWMOut can create tones and buzzes.
Workaround: I2SOut audio is currently being developed and will work with boards
such as the Adafruit I2S Stereo Decoder - UDA1334A Breakout ().

Deep Sleep & Wake-up sources
ESP32-S2 has hardware limitations on what kind of "pin alarms" can wake it. The
following combinations are possible:
• EITHER one or two pins that wake from deep sleep when they are pulled
LOW
• OR an arbitrary number of pins that wake from deep sleep when they are
pulled HIGH, and optionally one pin that wakes from deep sleep when pulled
LOW
This means that "wake" buttons should be wired so that pressing them pulls HIGH
and a pull DOWN resistor is used with the pin. However, in some hardware designs
including the original MagTag, the integrated buttons are pulled LOW when
pressed and so only 1 or 2 buttons can be selected to wake the MagTag.

Troubleshooting
From time to time, you will run into issues when working with CircuitPython. Here are
a few things you may encounter and how to resolve them.
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As CircuitPython development continues and there are new releases, Adafruit
will stop supporting older releases. Visit https://circuitpython.org/downloads to
download the latest version of CircuitPython for your board. You must download
the CircuitPython Library Bundle that matches your version of CircuitPython.
Please update CircuitPython and then visit https://circuitpython.org/libraries to
download the latest Library Bundle.

Always Run the Latest Version of
CircuitPython and Libraries
As CircuitPython development continues and there are new releases, Adafruit will
stop supporting older releases. You need to update to the latest CircuitPython. ().
You need to download the CircuitPython Library Bundle that matches your version of
CircuitPython. Please update CircuitPython and then download the latest bundle ().
As new versions of CircuitPython are released, Adafruit will stop providing the
previous bundles as automatically created downloads on the Adafruit CircuitPython
Library Bundle repo. If you must continue to use an earlier version, you can still
download the appropriate version of mpy-cross from the particular release of
CircuitPython on the CircuitPython repo and create your own compatible .mpy library
files. However, it is best to update to the latest for both CircuitPython and the library
bundle.

I have to continue using CircuitPython 5.x or earlier.
Where can I find compatible libraries?
Adafruit is no longer building or supporting the CircuitPython 5.x or earlier library
bundles. You are highly encourged to update CircuitPython to the latest version () and
use the current version of the libraries (). However, if for some reason you cannot
update, links to the previous bundles are available in the FAQ ().
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Bootloader (boardnameBOOT) Drive Not
Present
You may have a different board.
Only Adafruit Express boards and the SAMD21 non-Express boards ship with the UF2
bootloader ()installed. The Feather M0 Basic, Feather M0 Adalogger, and similar
boards use a regular Arduino-compatible bootloader, which does not show a boardna
meBOOT drive.

MakeCode
If you are running a MakeCode () program on Circuit Playground Express, press the
reset button just once to get the CPLAYBOOT drive to show up. Pressing it twice will
not work.

MacOS
DriveDx and its accompanything SAT SMART Driver can interfere with seeing the
BOOT drive. See this forum post () for how to fix the problem.

Windows 10
Did you install the Adafruit Windows Drivers package by mistake, or did you upgrade
to Windows 10 with the driver package installed? You don't need to install this
package on Windows 10 for most Adafruit boards. The old version (v1.5) can interfere
with recognizing your device. Go to Settings -> Apps and uninstall all the "Adafruit"
driver programs.

Windows 7 or 8.1
To use a CircuitPython-compatible board with Windows 7 or 8.1, you must install a
driver. Installation instructions are available here ().
It is recommended () that you upgrade to Windows 10 if possible; an upgrade is
probably still free for you. Check here ().
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The Windows Drivers installer was last updated in November 2020 (v2.5.0.0) .
Windows 7 drivers for CircuitPython boards released since then, including
RP2040 boards, are not yet available. The boards work fine on Windows 10. A
new release of the drivers is in process.
You should now be done! Test by unplugging and replugging the board. You should
see the CIRCUITPY drive, and when you double-click the reset button (single click on
Circuit Playground Express running MakeCode), you should see the appropriate boar
dnameBOOT drive.
Let us know in the Adafruit support forums () or on the Adafruit Discord () if this does
not work for you!

Windows Explorer Locks Up When
Accessing boardnameBOOT Drive
On Windows, several third-party programs that can cause issues. The symptom is that
you try to access the boardnameBOOT drive, and Windows or Windows Explorer
seems to lock up. These programs are known to cause trouble:
• AIDA64: to fix, stop the program. This problem has been reported to AIDA64.
They acquired hardware to test, and released a beta version that fixes the
problem. This may have been incorporated into the latest release. Please let us
know in the forums if you test this.
• Hard Disk Sentinel
• Kaspersky anti-virus: To fix, you may need to disable Kaspersky completely.
Disabling some aspects of Kaspersky does not always solve the problem. This
problem has been reported to Kaspersky.
• ESET NOD32 anti-virus: There have been problems with at least version
9.0.386.0, solved by uninstallation.

Copying UF2 to boardnameBOOT Drive
Hangs at 0% Copied
On Windows, a Western DIgital (WD) utility that comes with their external USB drives
can interfere with copying UF2 files to the boardnameBOOT drive. Uninstall that utility
to fix the problem.
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CIRCUITPY Drive Does Not Appear or
Disappears Quickly
Kaspersky anti-virus can block the appearance of the CIRCUITPY drive. There has not
yet been settings change discovered that prevents this. Complete uninstallation of
Kaspersky fixes the problem.
Norton anti-virus can interfere with CIRCUITPY. A user has reported this problem on
Windows 7. The user turned off both Smart Firewall and Auto Protect, and CIRCUITPY
then appeared.
Sophos Endpoint security software can cause CIRCUITPY to disappear () and the
BOOT drive to reappear. It is not clear what causes this behavior.

Device Errors or Problems on Windows
Windows can become confused about USB device installations. This is particularly
true of Windows 7 and 8.1. It is recommended () that you upgrade to Windows 10 if
possible; an upgrade is probably still free for you: see this link ().
If not, try cleaning up your USB devices. Use Uwe Sieber's Device Cleanup Tool () (on
that page, scroll down to "Device Cleanup Tool"). Download and unzip the tool.
Unplug all the boards and other USB devices you want to clean up. Run the tool as
Administrator. You will see a listing like this, probably with many more devices. It is
listing all the USB devices that are not currently attached.
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Select all the devices you want to remove, and then press Delete. It is usually safe
just to select everything. Any device that is removed will get a fresh install when you
plug it in. Using the Device Cleanup Tool also discards all the COM port assignments
for the unplugged boards. If you have used many Arduino and CircuitPython boards,
you have probably seen higher and higher COM port numbers used, seemingly
without end. This will fix that problem.

Serial Console in Mu Not Displaying
Anything
There are times when the serial console will accurately not display anything, such as,
when no code is currently running, or when code with no serial output is already
running before you open the console. However, if you find yourself in a situation
where you feel it should be displaying something like an error, consider the following.
Depending on the size of your screen or Mu window, when you open the serial
console, the serial console panel may be very small. This can be a problem. A basic
CircuitPython error takes 10 lines to display!
Auto-reload is on. Simply save files over USB to run them or enter REPL to disable.
code.py output:
Traceback (most recent call last):
File "code.py", line 7
SyntaxError: invalid syntax

Press any key to enter the REPL. Use CTRL-D to reload.

More complex errors take even more lines!
Therefore, if your serial console panel is five lines tall or less, you may only see blank
lines or blank lines followed by Press any key to enter the REPL. Use CTRL-D
to reload. . If this is the case, you need to either mouse over the top of the panel to
utilise the option to resize the serial panel, or use the scrollbar on the right side to
scroll up and find your message.

This applies to any kind of serial output whether it be error messages or print
statements. So before you start trying to debug your problem on the hardware side,
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be sure to check that you haven't simply missed the serial messages due to serial
output panel height.

code.py Restarts Constantly
CircuitPython will restart code.py if you or your computer writes to something on the
CIRCUITPY drive. This feature is called auto-reload, and lets you test a change to your
program immediately.
Some utility programs, such as backup, anti-virus, or disk-checking apps, will write to
the CIRCUITPY as part of their operation. Sometimes they do this very frequently,
causing constant restarts.
Acronis True Image and related Acronis programs on Windows are known to cause
this problem. It is possible to prevent this by disabling the " ()Acronis Managed
Machine Service Mini" ().
If you cannot stop whatever is causing the writes, you can disable auto-reload by
putting this code in boot.py or code.py:
import supervisor
supervisor.disable_autoreload()

CircuitPython RGB Status Light
Nearly all CircuitPython-capable boards have a single NeoPixel or DotStar RGB LED
on the board that indicates the status of CircuitPython. A few boards designed before
CircuitPython existed, such as the Feather M0 Basic, do not.
Circuit Playground Express and Circuit Playground Bluefruit have multiple RGB LEDs,
but do NOT have a status LED. The LEDs are all green when in the bootloader. In
versions before 7.0.0, they do NOT indicate any status while running CircuitPython.

CircuitPython 7.0.0 and Later
The status LED blinks were changed in CircuitPython 7.0.0 in order to save battery
power and simplify the blinks. These blink patterns will occur on single color LEDs
when the board does not have any RGB LEDs. Speed and blink count also vary for
this reason.
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On start up, the LED will blink YELLOW multiple times for 1 second. Pressing the
RESET button (or on Espressif, the BOOT button) during this time will restart the board
and then enter safe mode. On Bluetooth capable boards, after the yellow blinks, there
will be a set of faster blue blinks. Pressing reset during the BLUE blinks will clear
Bluetooth information and start the device in discoverable mode, so it can be used
with a BLE code editor.
Once started, CircuitPython will blink a pattern every 5 seconds when no user code is
running to indicate why the code stopped:
• 1 GREEN blink: Code finished without error.
• 2 RED blinks: Code ended due to an exception. Check the serial console for
details.
• 3 YELLOW blinks: CircuitPython is in safe mode. No user code was run. Check
the serial console for safe mode reason.
When in the REPL, CircuitPython will set the status LED to WHITE. You can change the
LED color from the REPL. The status indicator will not persist on non-NeoPixel or
DotStar LEDs.

CircuitPython 6.3.0 and earlier
Here's what the colors and blinking mean:
• steady GREEN: code.py (or code.txt, main.py, or main.txt) is running

©Adafruit Industries

Page 76 of 141

• pulsing GREEN: code.py (etc.) has finished or does not exist
• steady YELLOW at start up: (4.0.0-alpha.5 and newer) CircuitPython is waiting for
a reset to indicate that it should start in safe mode
• pulsing YELLOW: Circuit Python is in safe mode: it crashed and restarted
• steady WHITE: REPL is running
• steady BLUE: boot.py is running
Colors with multiple flashes following indicate a Python exception and then indicate
the line number of the error. The color of the first flash indicates the type of error:
• GREEN: IndentationError
• CYAN: SyntaxError
• WHITE: NameError
• ORANGE: OSError
• PURPLE: ValueError
• YELLOW: other error
These are followed by flashes indicating the line number, including place value. WHIT
E flashes are thousands' place, BLUE are hundreds' place, YELLOW are tens' place,
and CYAN are one's place. So for example, an error on line 32 would flash YELLOW
three times and then CYAN two times. Zeroes are indicated by an extra-long dark gap.
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Serial console showing ValueError:
Incompatible .mpy file

This error occurs when importing a module that is stored as a .mpy binary file that
was generated by a different version of CircuitPython than the one its being loaded
into. In particular, the mpy binary format changed between CircuitPython versions 6.x
and 7.x, 2.x and 3.x, and 1.x and 2.x.
So, for instance, if you upgraded to CircuitPython 7.x from 6.x you’ll need to download
a newer version of the library that triggered the error on import . All libraries are
available in the Adafruit bundle ().

CIRCUITPY Drive Issues
You may find that you can no longer save files to your CIRCUITPY drive. You may find
that your CIRCUITPY stops showing up in your file explorer, or shows up as NO_NAM
E. These are indicators that your filesystem has issues. When the CIRCUITPY disk is
not safely ejected before being reset by the button or being disconnected from USB,
it may corrupt the flash drive. It can happen on Windows, Mac or Linux, though it is
more common on Windows.
Be aware, if you have used Arduino to program your board, CircuitPython is no longer
able to provide the USB services. You will need to reload CircuitPython to resolve this
situation.
The easiest first step is to reload CircuitPython. Double-tap reset on the board so you
get a boardnameBOOT drive rather than a CIRCUITPY drive, and copy the latest
version of CircuitPython (.uf2) back to the board. This may restore CIRCUITPY
functionality.
If reloading CircuitPython does not resolve your issue, the next step is to try putting
the board into safe mode.

Safe Mode
Whether you've run into a situation where you can no longer edit your code.py on
your CIRCUITPY drive, your board has gotten into a state where CIRCUITPY is readonly, or you have turned off the CIRCUITPY drive altogether, safe mode can help.
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Safe mode in CircuitPython does not run any user code on startup, and disables autoreload. This means a few things. First, safe mode bypasses any code in boot.py
(where you can set CIRCUITPY read-only or turn it off completely). Second, it does not
run the code in code.py. And finally, it does not automatically soft-reload when data is
written to the CIRCUITPY drive.
Therefore, whatever you may have done to put your board in a non-interactive state,
safe mode gives you the opportunity to correct it without losing all of the data on the
CIRCUITPY drive.

Entering Safe Mode in CircuitPython 7.x and Later
To enter safe mode when using CircuitPython 7.x, plug in your board or hit reset
(highlighted in red above). Immediately after the board starts up or resets, it waits
1000ms. On some boards, the onboard status LED will blink yellow during that time. If
you press reset during that 1000ms, the board will start up in safe mode. It can be
difficult to react to the yellow LED, so you may want to think of it simply as a "slow"
double click of the reset button. (Remember, a fast double click of reset enters the
bootloader.)

Entering Safe Mode in CircuitPython 6.x
To enter safe mode when using CircuitPython 6.x, plug in your board or hit reset
(highlighted in red above). Immediately after the board starts up or resets, it waits
700ms. On some boards, the onboard status LED (highlighted in green above) will
turn solid yellow during this time. If you press reset during that 700ms, the board will
start up in safe mode. It can be difficult to react to the yellow LED, so you may want to
think of it simply as a slow double click of the reset button. (Remember, a fast double
click of reset enters the bootloader.)

In Safe Mode
Once you've entered safe mode successfully in CircuitPython 6.x, the LED will pulse
yellow.
If you successfully enter safe mode on CircuitPython 7.x, the LED will intermittently
blink yellow three times.
If you connect to the serial console, you'll find the following message.
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Auto-reload is off.
Running in safe mode! Not running saved code.
CircuitPython is in safe mode because you pressed the reset button during boot.
Press again to exit safe mode.
Press any key to enter the REPL. Use CTRL-D to reload.

You can now edit the contents of the CIRCUITPY drive. Remember, your code will not
run until you press the reset button, or unplug and plug in your board, to get out of
safe mode.
At this point, you'll want to remove any user code in code.py and, if present, the boot.
py file from CIRCUITPY. Once removed, tap the reset button, or unplug and plug in
your board, to restart CircuitPython. This will restart the board and may resolve your
drive issues. If resolved, you can begin coding again as usual.
If safe mode does not resolve your issue, the board must be completely erased and
CircuitPython must be reloaded onto the board.
You WILL lose everything on the board when you complete the following steps. If
possible, make a copy of your code before continuing.

To erase CIRCUITPY: storage.erase_filesystem()
CircuitPython includes a built-in function to erase and reformat the filesystem. If you
have a version of CircuitPython older than 2.3.0 on your board, you can update to the
newest version () to do this.
1. Connect to the CircuitPython REPL () using Mu or a terminal program.
2. Type the following into the REPL:
&gt;&gt;&gt; import storage
&gt;&gt;&gt; storage.erase_filesystem()

CIRCUITPY will be erased and reformatted, and your board will restart. That's it!

Erase CIRCUITPY Without Access to the REPL
If you can't access the REPL, or you're running a version of CircuitPython previous to
2.3.0 and you don't want to upgrade, there are options available for some specific
boards.
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The options listed below are considered to be the "old way" of erasing your board.
The method shown above using the REPL is highly recommended as the best method
for erasing your board.
If at all possible, it is recommended to use the REPL to erase your CIRCUITPY
drive. The REPL method is explained above.

For the specific boards listed below:
If the board you are trying to erase is listed below, follow the steps to use the file to
erase your board.
1. Download the correct erase file:

Circuit Playground Express
Feather M0 Express
Feather M4 Express
Metro M0 Express
Metro M4 Express QSPI Eraser
Trellis M4 Express (QSPI)
Grand Central M4 Express (QSPI)
PyPortal M4 Express (QSPI)
Circuit Playground Bluefruit (QSPI)
Monster M4SK (QSPI)
PyBadge/PyGamer QSPI Eraser.UF2
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CLUE_Flash_Erase.UF2
Matrix_Portal_M4_(QSPI).UF2
2. Double-click the reset button on the board to bring up the boardnameBOOT
drive.
3. Drag the erase .uf2 file to the boardnameBOOT drive.
4. The status LED will turn yellow or blue, indicating the erase has started.
5. After approximately 15 seconds, the status LED will light up green. On the
NeoTrellis M4 this is the first NeoPixel on the grid
6. Double-click the reset button on the board to bring up the boardnameBOOT d
rive.
7. Drag the appropriate latest release of CircuitPython () .uf2 file to the boardnam
eBOOT drive.
It should reboot automatically and you should see CIRCUITPY in your file explorer
again.
If the LED flashes red during step 5, it means the erase has failed. Repeat the steps
starting with 2.
If you haven't already downloaded the latest release of CircuitPython for your board,
check out the installation page (). You'll also need to load your code and reinstall your
libraries!

For SAMD21 non-Express boards that have a UF2
bootloader:
Any SAMD21-based microcontroller that does not have external flash available is
considered a SAMD21 non-Express board. Non-Express boards that have a UF2
bootloader include Trinket M0, GEMMA M0, QT Py M0, and the SAMD21-based
Trinkey boards.
If you are trying to erase a SAMD21 non-Express board, follow these steps to erase
your board.
1. Download the erase file:

SAMD21 non-Express Boards
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2. Double-click the reset button on the board to bring up the boardnameBOOT
drive.
3. Drag the erase .uf2 file to the boardnameBOOT drive.
4. The boot LED will start flashing again, and the boardnameBOOT drive will
reappear.
5. Drag the appropriate latest release CircuitPython () .uf2 file to the
boardnameBOOT drive.
It should reboot automatically and you should see CIRCUITPY in your file explorer
again.
If you haven't already downloaded the latest release of CircuitPython for your board,
check out the installation page () YYou'll also need to load your code and reinstall
your libraries!

For SAMD21 non-Express boards that do not have a UF2
bootloader:
Any SAMD21-based microcontroller that does not have external flash available is
considered a SAMD21 non-Express board. Non-Express boards that do not have a
UF2 bootloader include the Feather M0 Basic Proto, Feather Adalogger, or the
Arduino Zero.
If you are trying to erase a non-Express board that does not have a UF2 bootloader, f
ollow these directions to reload CircuitPython using bossac (), which will erase and
re-create CIRCUITPY.

Running Out of File Space on SAMD21 NonExpress Boards
Any SAMD21-based microcontroller that does not have external flash available is
considered a SAMD21 non-Express board. This includes boards like the Trinket M0,
GEMMA M0, QT Py M0, and the SAMD21-based Trinkey boards.
The file system on the board is very tiny. (Smaller than an ancient floppy disk.) So, its
likely you'll run out of space but don't panic! There are a number of ways to free up
space.
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Delete something!
The simplest way of freeing up space is to delete files from the drive. Perhaps there
are libraries in the lib folder that you aren't using anymore or test code that isn't in
use. Don't delete the lib folder completely, though, just remove what you don't need.
The board ships with the Windows 7 serial driver too! Feel free to delete that if you
don't need it or have already installed it. It's ~12KiB or so.

Use tabs
One unique feature of Python is that the indentation of code matters. Usually the
recommendation is to indent code with four spaces for every indent. In general, that
is recommended too. However, one trick to storing more human-readable code is to
use a single tab character for indentation. This approach uses 1/4 of the space for
indentation and can be significant when you're counting bytes.

On MacOS?
MacOS loves to generate hidden files. Luckily you can disable some of the extra
hidden files that macOS adds by running a few commands to disable search indexing
and create zero byte placeholders. Follow the steps below to maximize the amount of
space available on macOS.

Prevent & Remove MacOS Hidden Files
First find the volume name for your board. With the board plugged in run this
command in a terminal to list all the volumes:
ls -l /Volumes
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Look for a volume with a name like CIRCUITPY (the default for CircuitPython). The full
path to the volume is the /Volumes/CIRCUITPY path.
Now follow the steps from this question () to run these terminal commands that stop
hidden files from being created on the board:
mdutil -i off /Volumes/CIRCUITPY
cd /Volumes/CIRCUITPY
rm -rf .{,_.}{fseventsd,Spotlight-V*,Trashes}
mkdir .fseventsd
touch .fseventsd/no_log .metadata_never_index .Trashes
cd -

Replace /Volumes/CIRCUITPY in the commands above with the full path to your
board's volume if it's different. At this point all the hidden files should be cleared from
the board and some hidden files will be prevented from being created.
Alternatively, with CircuitPython 4.x and above, the special files and folders
mentioned above will be created automatically if you erase and reformat the
filesystem. WARNING: Save your files first! Do this in the REPL:
>>> import storage
>>> storage.erase_filesystem()

However there are still some cases where hidden files will be created by MacOS. In
particular if you copy a file that was downloaded from the internet it will have special
metadata that MacOS stores as a hidden file. Luckily you can run a copy command
from the terminal to copy files without this hidden metadata file. See the steps below.

Copy Files on MacOS Without Creating Hidden Files
Once you've disabled and removed hidden files with the above commands on macOS
you need to be careful to copy files to the board with a special command that
prevents future hidden files from being created. Unfortunately you cannot use drag
and drop copy in Finder because it will still create these hidden extended attribute
files in some cases (for files downloaded from the internet, like Adafruit's modules).
To copy a file or folder use the -X option for the cp command in a terminal. For
example to copy a file_name.mpy file to the board use a command like:
cp -X file_name.mpy /Volumes/CIRCUITPY
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(Replace file_name.mpy with the name of the file you want to copy.)
Or to copy a folder and all of the files and folders contained within, use a command
like:
cp -rX folder_to_copy /Volumes/CIRCUITPY

If you are copying to the lib folder, or another folder, make sure it exists before
copying.
# if lib does not exist, you'll create a file named lib !
cp -X file_name.mpy /Volumes/CIRCUITPY/lib
# This is safer, and will complain if a lib folder does not exist.
cp -X file_name.mpy /Volumes/CIRCUITPY/lib/

Other MacOS Space-Saving Tips
If you'd like to see the amount of space used on the drive and manually delete hidden
files here's how to do so. First, move into the Volumes/ directory with cd /Volumes/ ,
and then list the amount of space used on the CIRCUITPY drive with the df
command.

That's not very much space left! The next step is to show a list of the files currently on
the CIRCUITPY drive, including the hidden files, using the ls command. You cannot
use Finder to do this, you must do it via command line!

There are a few of the hidden files that MacOS loves to generate, all of which begin
with a ._ before the file name. Remove the ._ files using the rm command. You can
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remove them all once by running rm CIRCUITPY/._* . The * acts as a wildcard to
apply the command to everything that begins with ._ at the same time.

Finally, you can run df again to see the current space used.

Nice! You have 12Ki more than before! This space can now be used for libraries and
code!

Device Locked Up or Boot Looping
In rare cases, it may happen that something in your code.py or boot.py files causes
the device to get locked up, or even go into a boot loop. A boot loop occurs when the
board reboots repeatedly and never fully loads. These are not caused by your
everyday Python exceptions, typically it's the result of a deeper problem within
CircuitPython. In this situation, it can be difficult to recover your device if CIRCUITPY
is not allowing you to modify the code.py or boot.py files. Safe mode is one recovery
option. When the device boots up in safe mode it will not run the code.py or boot.py
scripts, but will still connect the CIRCUITPY drive so that you can remove or modify
those files as needed.
The method used to manually enter safe mode can be different for different devices.
It is also very similar to the method used for getting into bootloader mode, which is a
different thing. So it can take a few tries to get the timing right. If you end up in
bootloader mode, no problem, you can try again without needing to do anything else.
For most devices:
Press the reset button, and then when the RGB status LED blinks yellow, press the
reset button again. Since your reaction time may not be that fast, try a "slow" double
click, to catch the yellow LED on the second click.
For ESP32-S2 based devices:
Press and release the reset button, then press and release the boot button about 3/4
of a second later.
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Refer to the diagrams above for boot sequence details.

Welcome to the Community!

CircuitPython is a programming language that's super simple to get started with and
great for learning. It runs on microcontrollers and works out of the box. You can plug it
in and get started with any text editor. The best part? CircuitPython comes with an
amazing, supportive community.
Everyone is welcome! CircuitPython is Open Source. This means it's available for
anyone to use, edit, copy and improve upon. This also means CircuitPython becomes
better because of you being a part of it. Whether this is your first microcontroller
board or you're a seasoned software engineer, you have something important to offer
the Adafruit CircuitPython community. This page highlights some of the many ways
you can be a part of it!
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Adafruit Discord

The Adafruit Discord server is the best place to start. Discord is where the community
comes together to volunteer and provide live support of all kinds. From general
discussion to detailed problem solving, and everything in between, Discord is a digital
maker space with makers from around the world.
There are many different channels so you can choose the one best suited to your
needs. Each channel is shown on Discord as "#channelname". There's the #help-withprojects channel for assistance with your current project or help coming up with ideas
for your next one. There's the #show-and-tell channel for showing off your newest
creation. Don't be afraid to ask a question in any channel! If you're unsure, #general is
a great place to start. If another channel is more likely to provide you with a better
answer, someone will guide you.
The help with CircuitPython channel is where to go with your CircuitPython questions.
#help-with-circuitpython is there for new users and developers alike so feel free to
ask a question or post a comment! Everyone of any experience level is welcome to
join in on the conversation. Your contributions are important! The #circuitpython-dev
channel is available for development discussions as well.
The easiest way to contribute to the community is to assist others on Discord.
Supporting others doesn't always mean answering questions. Join in celebrating
successes! Celebrate your mistakes! Sometimes just hearing that someone else has
gone through a similar struggle can be enough to keep a maker moving forward.
The Adafruit Discord is the 24x7x365 hackerspace that you can bring your
granddaughter to.
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Visit https://adafru.it/discord ()to sign up for Discord. Everyone is looking forward to
meeting you!

CircuitPython.org

Beyond the Adafruit Learn System, which you are viewing right now, the best place to
find information about CircuitPython is circuitpython.org (). Everything you need to get
started with your new microcontroller and beyond is available. You can do things like
download CircuitPython for your microcontroller () or download the latest
CircuitPython Library bundle (), or check out which single board computers support
Blinka (). You can also get to various other CircuitPython related things like Awesome
CircuitPython or the Python for Microcontrollers newsletter. This is all incredibly
useful, but it isn't necessarily community related. So why is it included here? The Cont
ributing page ().

CircuitPython itself is written in C. However, all of the Adafruit CircuitPython libraries
are written in Python. If you're interested in contributing to CircuitPython on the
Python side of things, check out circuitpython.org/contributing (). You'll find
information pertaining to every Adafruit CircuitPython library GitHub repository, giving
you the opportunity to join the community by finding a contributing option that works
for you.
Note the date on the page next to Current Status for:
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If you submit any contributions to the libraries, and do not see them reflected on the
Contributing page, it could be that the job that checks for new updates hasn't yet run
for today. Simply check back tomorrow!
Now, a look at the different options.

Pull Requests
The first tab you'll find is a list of open pull requests.

GitHub pull requests, or PRs, are opened when folks have added something to an
Adafruit CircuitPython library GitHub repo, and are asking for Adafruit to add, or
merge, their changes into the main library code. For PRs to be merged, they must first
be reviewed. Reviewing is a great way to contribute! Take a look at the list of open
pull requests, and pick one that interests you. If you have the hardware, you can test
code changes. If you don't, you can still check the code updates for syntax. In the
case of documentation updates, you can verify the information, or check it for spelling
and grammar. Once you've checked out the update, you can leave a comment letting
us know that you took a look. Once you've done that for a while, and you're more
comfortable with it, you can consider joining the CircuitPythonLibrarians review team.
The more reviewers we have, the more authors we can support. Reviewing is a crucial
part of an open source ecosystem, CircuitPython included.

Open Issues
The second tab you'll find is a list of open issues.
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GitHub issues are filed for a number of reasons, including when there is a bug in the
library or example code, or when someone wants to make a feature request. Issues
are a great way to find an opportunity to contribute directly to the libraries by
updating code or documentation. If you're interested in contributing code or
documentation, take a look at the open issues and find one that interests you.
If you're not sure where to start, you can search the issues by label. Labels are
applied to issues to make the goal easier to identify at a first glance, or to indicate the
difficulty level of the issue. Click on the dropdown next to "Sort by issue labels" to see
the list of available labels, and click on one to choose it.

If you're new to everything, new to contributing to open source, or new to
contributing to the CircuitPython project, you can choose "Good first issue". Issues
with that label are well defined, with a finite scope, and are intended to be easy for
someone new to figure out.
If you're looking for something a little more complicated, consider "Bug" or
"Enhancement". The Bug label is applied to issues that pertain to problems or failures
found in the library. The Enhancement label is applied to feature requests.
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Don't let the process intimidate you. If you're new to Git and GitHub, there is a guide ()
to walk you through the entire process. As well, there are always folks available on Di
scord () to answer questions.

Library Infrastructure Issues
The third tab you'll find is a list of library infrastructure issues.

This section is generated by a script that runs checks on the libraries, and then
reports back where there may be issues. It is made up of a list of subsections each
containing links to the repositories that are experiencing that particular issue. This
page is available mostly for internal use, but you may find some opportunities to
contribute on this page. If there's an issue listed that sounds like something you could
help with, mention it on Discord, or file an issue on GitHub indicating you're working
to resolve that issue. Others can reply either way to let you know what the scope of it
might be, and help you resolve it if necessary.

CircuitPython Localization
The fourth tab you'll find is the CircuitPython Localization tab.

If you speak another language, you can help translate CircuitPython! The translations
apply to informational and error messages that are within the CircuitPython core. It
means that folks who do not speak English have the opportunity to have these
messages shown to them in their own language when using CircuitPython. This is
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incredibly important to provide the best experience possible for all users.
CircuitPython uses Weblate to translate, which makes it much simpler to contribute
translations. You will still need to know some CircuitPython-specific practices and a
few basics about coding strings, but as with any CircuitPython contributions, folks are
there to help.
Regardless of your skill level, or how you want to contribute to the CircuitPython
project, there is an opportunity available. The Contributing page () is an excellent
place to start!

Adafruit GitHub

Whether you're just beginning or are life-long programmer who would like to
contribute, there are ways for everyone to be a part of the CircuitPython project. The
CircuitPython core is written in C. The libraries are written in Python. GitHub is the
best source of ways to contribute to the CircuitPython core (), and the CircuitPython
libraries (). If you need an account, visit https://github.com/ () and sign up.
If you're new to GitHub or programming in general, there are great opportunities for
you. For the CircuitPython core, head over to the CircuitPython repository on GitHub,
click on "Issues ()", and you'll find a list that includes issues labeled "good first issue ()"
. For the libraries, head over to the Contributing page Issues list (), and use the drop
down menu to search for "good first issue ()". These issues are things that have been
identified as something that someone with any level of experience can help with.
These issues include options like updating documentation, providing feedback, and
fixing simple bugs. If you need help getting started with GitHub, there is an excellent
guide on Contributing to CircuitPython with Git and GitHub ().

Already experienced and looking for a challenge? Checkout the rest of either issues
list and you'll find plenty of ways to contribute. You'll find all sorts of things, from new
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driver requests, to library bugs, to core module updates. There's plenty of
opportunities for everyone at any level!
When working with or using CircuitPython or the CircuitPython libraries, you may find
problems. If you find a bug, that's great! The team loves bugs! Posting a detailed issue
to GitHub is an invaluable way to contribute to improving CircuitPython. For
CircuitPython itself, file an issue here (). For the libraries, file an issue on the specific
library repository on GitHub. Be sure to include the steps to replicate the issue as well
as any other information you think is relevant. The more detail, the better!
Testing new software is easy and incredibly helpful. Simply load the newest version of
CircuitPython or a library onto your CircuitPython hardware, and use it. Let us know
about any problems you find by posting a new issue to GitHub. Software testing on
both stable and unstable releases is a very important part of contributing
CircuitPython. The developers can't possibly find all the problems themselves! They
need your help to make CircuitPython even better.
On GitHub, you can submit feature requests, provide feedback, report problems and
much more. If you have questions, remember that Discord and the Forums are both
there for help!

Adafruit Forums

The Adafruit Forums () are the perfect place for support. Adafruit has wonderful paid
support folks to answer any questions you may have. Whether your hardware is giving
you issues or your code doesn't seem to be working, the forums are always there for
you to ask. You need an Adafruit account to post to the forums. You can use the same
account you use to order from Adafruit.
While Discord may provide you with quicker responses than the forums, the forums
are a more reliable source of information. If you want to be certain you're getting an
Adafruit-supported answer, the forums are the best place to be.
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There are forum categories that cover all kinds of topics, including everything
Adafruit. The Adafruit CircuitPython () category under "Supported Products & Projects"
is the best place to post your CircuitPython questions.

Be sure to include the steps you took to get to where you are. If it involves wiring,
post a picture! If your code is giving you trouble, include your code in your post!
These are great ways to make sure that there's enough information to help you with
your issue.
You might think you're just getting started, but you definitely know something that
someone else doesn't. The great thing about the forums is that you can help others
too! Everyone is welcome and encouraged to provide constructive feedback to any of
the posted questions. This is an excellent way to contribute to the community and
share your knowledge!

Read the Docs

Read the Docs () is a an excellent resource for a more detailed look at the
CircuitPython core and the CircuitPython libraries. This is where you'll find things like
API documentation and example code. For an in depth look at viewing and
understanding Read the Docs, check out the CircuitPython Documentation () page!
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Install CircuitPython
CircuitPython () is a derivative of MicroPython () designed to simplify experimentation
and education on low-cost microcontrollers. It makes it easier than ever to get
prototyping by requiring no upfront desktop software downloads. Simply copy and
edit files on the CIRCUITPY drive to iterate.

Set Up CircuitPython
Follow the steps to get CircuitPython installed on your Metro ESP32-S2.

Download the latest CircuitPython
for your board from
circuitpython.org

Click the link above and download the
latest .BIN file.
Download and save it to your desktop (or
wherever is handy).
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Plug your Metro ESP32-S2 into your
computer using a known-good USB cable.
A lot of people end up using charge-only
USB cables and it is very frustrating! So
make sure you have a USB cable you
know is good for data sync.
Follow the 6 steps listed in the Enter the
ROM Bootloader section of the ROM
Bootloader page () to enter the bootloader.
Follow the initial steps found in the Run
esptool and check connection section of
the ROM Bootloader page () to verify your
environment is set up, your board is
successfully connected, and which port it's
using.
In the final command to write a binary file
to the board, replace the port with your
port, and replace "firmware.bin" with the
the file you downloaded above.
The output should look something like the
output in the image.

Press reset to exit the bootloader.
Your CIRCUITPY drive should appear!
You're all set!
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CircuitPython Pin Names
CircuitPython for the Metro ESP32-S2 uses different pin names than you may be used
to. Many CircuitPython boards use the D prefix for digital pin names, such as D1 or
D12. The pin names for the Metro ESP32-S2 use the IO prefix, such as IO1 or IO12.
The pin numbers on the Metro ESP32-S2 match the ESP32-S2 'low level chip pin
numbers' that ESP32 users are most familiar with. The pins are not numbered like
other typical Metro-shaped boards, so where you may expect pin 0 to be, its actually
IO5.
We're not yet using D prefix names to avoid the confusion of having D-prefix names
not match the IO pins.
The following pins have both the standard CircuitPython pin name and the IOx pin
name available:
• Analog pins A0-A5
• Default I2C port SCL & SDA
• Default SPI port SCK, MISO, MOSI
• Default hardware Serial port RX, TX
• LED (red LED)
• NEOPIXEL (built in RGB LED)

Pin Name Diagram
The following diagram shows the standard CircuitPython pin names, the IO pin
names, the singleton names and the debug/DFU pins.
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CircuitPython Internet Test
One of the great things about the ESP32 is the built-in WiFi capabilities. This page
covers the basics of getting connected using CircuitPython.
The first thing you need to do is update your code.py to the following. Click the Downl
oad Project Bundle button below to download the necessary libraries and the code.py
file in a zip file. Extract the contents of the zip file, and copy the entire lib folder and
the code.py file to your CIRCUITPY drive.
# SPDX-FileCopyrightText: 2020 Brent Rubell for Adafruit Industries
#
# SPDX-License-Identifier: MIT
import
import
import
import
import

ipaddress
ssl
wifi
socketpool
adafruit_requests

# URLs to fetch from
TEXT_URL = "http://wifitest.adafruit.com/testwifi/index.html"
JSON_QUOTES_URL = "https://www.adafruit.com/api/quotes.php"
JSON_STARS_URL = "https://api.github.com/repos/adafruit/circuitpython"
# Get wifi details and more from a secrets.py file
try:
from secrets import secrets
except ImportError:
print("WiFi secrets are kept in secrets.py, please add them there!")
raise
print("ESP32-S2 WebClient Test")
print("My MAC addr:", [hex(i) for i in wifi.radio.mac_address])
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print("Available WiFi networks:")
for network in wifi.radio.start_scanning_networks():
print("\t%s\t\tRSSI: %d\tChannel: %d" % (str(network.ssid, "utf-8"),
network.rssi, network.channel))
wifi.radio.stop_scanning_networks()
print("Connecting to %s"%secrets["ssid"])
wifi.radio.connect(secrets["ssid"], secrets["password"])
print("Connected to %s!"%secrets["ssid"])
print("My IP address is", wifi.radio.ipv4_address)
ipv4 = ipaddress.ip_address("8.8.4.4")
print("Ping google.com: %f ms" % (wifi.radio.ping(ipv4)*1000))
pool = socketpool.SocketPool(wifi.radio)
requests = adafruit_requests.Session(pool, ssl.create_default_context())
print("Fetching text from", TEXT_URL)
response = requests.get(TEXT_URL)
print("-" * 40)
print(response.text)
print("-" * 40)
print("Fetching json from", JSON_QUOTES_URL)
response = requests.get(JSON_QUOTES_URL)
print("-" * 40)
print(response.json())
print("-" * 40)
print()
print("Fetching and parsing json from", JSON_STARS_URL)
response = requests.get(JSON_STARS_URL)
print("-" * 40)
print("CircuitPython GitHub Stars", response.json()["stargazers_count"])
print("-" * 40)
print("done")

Your CIRCUITPY drive should resemble the following.

To get connected, the next thing you need to do is update the secrets.py file.

Secrets File
We expect people to share tons of projects as they build CircuitPython WiFi widgets.
What we want to avoid is people accidentally sharing their passwords or secret
tokens and API keys. So, we designed all our examples to use a secrets.py file, that is
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on your CIRCUITPY drive, to hold secret/private/custom data. That way you can share
your main project without worrying about accidentally sharing private stuff.
The initial secrets.py file on your CIRCUITPY drive should look like this:
# SPDX-FileCopyrightText: 2020 Adafruit Industries
#
# SPDX-License-Identifier: Unlicense
# This file is where you keep secret settings, passwords, and tokens!
# If you put them in the code you risk committing that info or sharing it
secrets = {
'ssid' : 'home_wifi_network',
'password' : 'wifi_password',
'aio_username' : 'my_adafruit_io_username',
'aio_key' : 'my_adafruit_io_key',
'timezone' : "America/New_York", # http://worldtimeapi.org/timezones
}

Inside is a Python dictionary named secrets with a line for each entry. Each entry has
an entry name (say 'ssid' ) and then a colon to separate it from the entry key
( 'home_wifi_network' ) and finally a comma ( , ).
At a minimum you'll need to adjust the ssid and password for your local WiFi setup
so do that now!
As you make projects you may need more tokens and keys, just add them one line at
a time. See for example other tokens such as one for accessing GitHub or the
Hackaday API. Other non-secret data like your timezone can also go here, just cause
its called secrets doesn't mean you can't have general customization data in there!
For the correct time zone string, look at http://worldtimeapi.org/timezones () and
remember that if your city is not listed, look for a city in the same time zone, for
example Boston, New York, Philadelphia, Washington DC, and Miami are all on the
same time as New York.
Of course, don't share your secrets.py - keep that out of GitHub, Discord or other
project-sharing sites.
Don't share your secrets.py file, it has your passwords and API keys in it!
If you connect to the serial console, you should see something like the following:
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In order, the example code...
Checks the ESP32's MAC address.
print("My MAC addr:", [hex(i) for i in wifi.radio.mac_address])

Performs a scan of all access points and prints out the access point's name (SSID),
signal strength (RSSI), and channel.
print("Avaliable WiFi networks:")
for network in wifi.radio.start_scanning_networks():
print("\t%s\t\tRSSI: %d\tChannel: %d" % (str(network.ssid, "utf-8"),
network.rssi, network.channel))
wifi.radio.stop_scanning_networks()

Connects to the access point you defined in the secrets.py file, prints out its local IP
address, and attempts to ping google.com to check its network connectivity.
print("Connecting to %s"%secrets["ssid"])
wifi.radio.connect(secrets["ssid"], secrets["password"])
print(print("Connected to %s!"%secrets["ssid"]))
print("My IP address is", wifi.radio.ipv4_address)
ipv4 = ipaddress.ip_address("8.8.4.4")
print("Ping google.com: %f ms" % wifi.radio.ping(ipv4))
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The code creates a socketpool using the wifi radio's available sockets. This is
performed so we don't need to re-use sockets. Then, it initializes a a new instance of
the requests () interface - which makes getting data from the internet really really
easy.
pool = socketpool.SocketPool(wifi.radio)
requests = adafruit_requests.Session(pool, ssl.create_default_context())

To read in plain-text from a web URL, call requests.get - you may pass in either a
http, or a https url for SSL connectivity.
print("Fetching text from", TEXT_URL)
response = requests.get(TEXT_URL)
print("-" * 40)
print(response.text)
print("-" * 40)

Requests can also display a JSON-formatted response from a web URL using a call to
requests.get .
print("Fetching json from", JSON_QUOTES_URL)
response = requests.get(JSON_QUOTES_URL)
print("-" * 40)
print(response.json())
print("-" * 40)

Finally, you can fetch and parse a JSON URL using requests.get . This code snippet
obtains the stargazers_count field from a call to the GitHub API.
print("Fetching and parsing json from", JSON_STARS_URL)
response = requests.get(JSON_STARS_URL)
print("-" * 40)
print("CircuitPython GitHub Stars", response.json()["stargazers_count"])
print("-" * 40)

OK you now have your ESP32 board set up with a proper secrets.py file and can
connect over the Internet. If not, check that your secrets.py file has the right ssid and
password and retrace your steps until you get the Internet connectivity working!

Getting The Date & Time
A very common need for projects is to know the current date and time. Especially
when you want to deep sleep until an event, or you want to change your display
based on what day, time, date, etc. it is

©Adafruit Industries

Page 104 of 141

Determining the correct local time is really really hard. There are various time zones,
Daylight Savings dates, leap seconds, etc. Trying to get NTP time and then backcalculating what the local time is, is extraordinarily hard on a microcontroller just isn't
worth the effort and it will get out of sync as laws change anyways.
For that reason, we have the free adafruit.io time service. Free for anyone with a free
adafruit.io account. You do need an account because we have to keep accidentally
mis-programmed-board from overwhelming adafruit.io and lock them out temporarily.
Again, it's free!
There are other services like WorldTimeAPI, but we don't use those for our
guides because they are nice people and we don't want to accidentally overload
their site. Also, there's a chance it may eventually go down or also require an
account.

Step 1) Make an Adafruit account
It's free! Visit https://accounts.adafruit.com/ () to register and make an account if you
do not already have one

Step 2) Sign into Adafruit IO
Head over to io.adafruit.com () and click Sign In to log into IO using your Adafruit
account. It's free and fast to join.

Step 3) Get your Adafruit IO Key
Click on My Key in the top bar

You will get a popup with your Username and Key (In this screenshot, we've covered it
with red blocks)
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Go to your secrets.py file on your CIRCUITPY drive and add three lines for
aio_username , aio_key and timezone so you get something like the following:
# This file is where you keep secret settings, passwords, and tokens!
# If you put them in the code you risk committing that info or sharing it
secrets = {
'ssid' : 'home_wifi_network',
'password' : 'wifi_password',
'aio_username' : 'my_adafruit_io_username',
'aio_key' : 'my_adafruit_io_key',
'timezone' : "America/New_York", # http://worldtimeapi.org/timezones
}

The timezone is optional, if you don't have that entry, adafruit.io will guess your
timezone based on geographic IP address lookup. You can visit http://
worldtimeapi.org/timezones () to see all the time zones available (even though we do
not use Worldtime for time-keeping, we do use the same time zone table).

Step 4) Upload Test Python Code
This code is like the Internet Test code from before, but this time it will connect to
adafruit.io and get the local time
import
import
import
import
import
import

ipaddress
ssl
wifi
socketpool
adafruit_requests
secrets

TEXT_URL = "http://wifitest.adafruit.com/testwifi/index.html"
JSON_QUOTES_URL = "https://www.adafruit.com/api/quotes.php"
JSON_STARS_URL = "https://api.github.com/repos/adafruit/circuitpython"
# Get wifi details and more from a secrets.py file
try:
from secrets import secrets
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except ImportError:
print("WiFi secrets are kept in secrets.py, please add them there!")
raise
# Get our username, key and desired timezone
aio_username = secrets["aio_username"]
aio_key = secrets["aio_key"]
location = secrets.get("timezone", None)
TIME_URL = "https://io.adafruit.com/api/v2/%s/integrations/time/strftime?x-aiokey=%s&amp;tz=%s" % (aio_username, aio_key, location)
TIME_URL += "&amp;fmt=%25Y-%25m-%25d+%25H%3A%25M%3A%25S.%25L+%25j+%25u+%25z+%25Z"
print("ESP32-S2 Adafruit IO Time test")
print("My MAC addr:", [hex(i) for i in wifi.radio.mac_address])
print("Available WiFi networks:")
for network in wifi.radio.start_scanning_networks():
print("\t%s\t\tRSSI: %d\tChannel: %d" % (str(network.ssid, "utf-8"),
network.rssi, network.channel))
wifi.radio.stop_scanning_networks()
print("Connecting to %s"%secrets["ssid"])
wifi.radio.connect(secrets["ssid"], secrets["password"])
print("Connected to %s!"%secrets["ssid"])
print("My IP address is", wifi.radio.ipv4_address)
ipv4 = ipaddress.ip_address("8.8.4.4")
print("Ping google.com: %f ms" % wifi.radio.ping(ipv4))
pool = socketpool.SocketPool(wifi.radio)
requests = adafruit_requests.Session(pool, ssl.create_default_context())
print("Fetching text from", TIME_URL)
response = requests.get(TIME_URL)
print("-" * 40)
print(response.text)
print("-" * 40)

After running this, you will see something like the below text. We have blocked out
the part with the secret username and key data!

Note at the end you will get the date, time, and your timezone! If so, you have
correctly configured your secrets.py and can continue to the next steps!
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CircuitPython Essentials

You've been introduced to CircuitPython, and worked through getting everything set
up. What's next? CircuitPython Essentials!
There are a number of core modules built into CircuitPython, which can be used along
side the many CircuitPython libraries available. The following pages demonstrate
some of these modules. Each page presents a different concept including a code
example with an explanation. All of the examples are designed to work with your
microcontroller board.
Time to get started learning the CircuitPython essentials!

Blink
In learning any programming language, you often begin with some sort of Hello,
World! program. In CircuitPython, Hello, World! is blinking an LED. Blink is one of the
simplest programs in CircuitPython. It involves three built-in modules, two lines of set
up, and a short loop. Despite its simplicity, it shows you many of the basic concepts
needed for most CircuitPython programs, and provides a solid basis for more complex
projects. Time to get blinky!
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LED Location

The Built-in Red LED is located in the
upper right of the board below the OK LED
and has the number 42 to the left of it.

Blinking an LED
In the example below, click the Download Project Bundle button below to download
the necessary libraries and the code.py file in a zip file. Extract the contents of the zip
file, open the directory CircuitPython_Templates/blink/ and then click on the directory
that matches the version of CircuitPython you're using and copy the contents of that
directory to your CIRCUITPY drive.
Your CIRCUITPY drive should now look similar to the following image:

# SPDX-FileCopyrightText: 2021 Kattni Rembor for Adafruit Industries
# SPDX-License-Identifier: MIT
"""CircuitPython Blink Example - the CircuitPython 'Hello, World!'"""
import time
import board
import digitalio
led = digitalio.DigitalInOut(board.LED)
led.direction = digitalio.Direction.OUTPUT
while True:
led.value = True
time.sleep(0.5)
led.value = False
time.sleep(0.5)
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The built-in LED begins blinking!
Note that the code is a little less "Pythonic" than it could be. It could also be written as
led.value = not led.value with a single time.sleep(0.5) . That way is more
difficult to understand if you're new to programming, so the example is a bit longer
than it needed to be to make it easier to read.
It's important to understand what is going on in this program.
First you import three modules: time , board and digitalio . This makes these
modules available for use in your code. All three are built-in to CircuitPython, so you
don't need to download anything to get started.
Next, you set up the LED. To interact with hardware in CircuitPython, your code must
let the board know where to look for the hardware and what to do with it. So, you
create a digitalio.DigitalInOut() object, provide it the LED pin using the boar
d module, and save it to the variable led . Then, you tell the pin to act as an
OUTPUT .
Finally, you create a while True: loop. This means all the code inside the loop will
repeat indefinitely. Inside the loop, you set led.value = True which powers on the
LED. Then, you use time.sleep(0.5) to tell the code to wait half a second before
moving on to the next line. The next line sets led.value = False which turns the
LED off. Then you use another time.sleep(0.5) to wait half a second before
starting the loop over again.
With only a small update, you can control the blink speed. The blink speed is
controlled by the amount of time you tell the code to wait before moving on using
time.sleep() . The example uses 0.5 , which is one half of one second. Try
increasing or decreasing these values to see how the blinking changes.
That's all there is to blinking an LED using CircuitPython!

Arduino IDE Setup
The ESP32-S2/S3 bootloader does not have USB serial support for Windows 7 or
8. (See https://github.com/espressif/arduino-esp32/issues/5994) please update
to version 10 which is supported by espressif! Alternatively you can try this
community-crafted Windows 7 driver (https://github.com/kutukvpavel/Esp32-Win7VCP-drivers)
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The first thing you will need to do is to download the latest release of the Arduino
IDE. You will need to be using version 1.8 or higher for this guide

Arduino IDE Download
The ESP32-S2/S3 Arduino board support package is currently part of the 2.0.0 or
later release. To use the ESP32-S2/S3 with Arduino, you'll need to follow the steps
below for your operating system. You can also check out the Espressif Arduino
repository for the most up to date details on how to install it ().
After you have downloaded and installed the latest version of Arduino IDE, you will
need to start the IDE and navigate to the Preferences menu. You can access it from
the File menu in Windows or Linux, or the Arduino menu on OS X.

A dialog will pop up just like the one shown below.
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We will be adding a URL to the new Additional Boards Manager URLs option. The list
of URLs is comma separated, and you will only have to add each URL once. New
Adafruit boards and updates to existing boards will automatically be picked up by the
Board Manager each time it is opened. The URLs point to index files that the Board
Manager uses to build the list of available & installed boards.
To find the most up to date list of URLs you can add, you can visit the list of third party
board URLs on the Arduino IDE wiki (). We will only need to add one URL to the IDE in
this example, but you can add multiple URLS by separating them with commas. Copy
and paste the link below into the Additional Boards Manager URLs option in the
Arduino IDE preferences.
https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/
package_esp32_dev_index.json
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If you have multiple boards you want to support, say ESP8266 and Adafruit, have
both URLs in the text box separated by a comma (,)
Once done click OK to save the new preference settings.
The next step is to actually install the Board Support Package (BSP). Go to the Tools →
Board → Board Manager submenu. A dialog should come up with various BSPs.
Search for esp32.

Click the Install button and wait for it to finish. Once it is finished, you can close the
dialog.
In the Tools → Board submenu you should see ESP32 Arduino and in that dropdown it
should contain the ESP32 boards along with all the latest ESP32-S2/S3 boards.
Look for the board called Adafruit Metro ESP32-S2.
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Using with Arduino IDE
Blink
Now you can upload your first blink sketch!
Plug in the ESP32-S2/S3 board and wait for it to be recognized by the OS (just takes a
few seconds).

Select ESP32-S2/S3 Board in Arduino IDE

On the Arduino IDE, click:
Tools -> Board -> ESP32 Arduino -> Your
Adafruit ESP32-S2/S3 board
The screenshot shows Metro S2 but you
may have a different board. Make sure the
name matches the exact product you
purchased. If you don't see your board,
make sure you have the latest version of
the ESP32 board support package

Launch ESP32-S2/S3 ROM Bootloader
ESP32-S2/S3 support in Arduino uses native USB which can crash. If you ever
DON'T see a serial/COM port, you can always manually enter bootloading mode.
This bootloader is in ROM, it is 'un-brickable' so you can always use this
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technique to get into the bootloader. However, after uploading your Arduino
code you MUST press reset to start the sketch
Before we upload a sketch, place your
ESP32-S2/S3 board into ROM bootloader
mode ().
Look for the Reset button and a second
DFU / BOOT0 button
HOLD down the DFU/Boot0 button while
you click Reset. Then release DFU/Boot0
button
The GIF shows a Metro S2 but your board
may look different. It will still have BOOT
and Reset buttons somewhere

It should appear under Tools -> Port as ESP32-S2/S3 Dev Module.

Do not select any other port than the one that is called "ESP32S2 Dev Module"
or "ESP32S3 Dev Module"

Load Blink Sketch
Now open up this Blink example in a new sketch window
// the setup function runs once when you press reset or power the board
void setup() {
// initialize built in LED pin as an output.
pinMode(LED_BUILTIN, OUTPUT);
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// initialize USB serial converter so we have a port created
Serial.begin();
}
// the loop function runs over and over
void loop() {
digitalWrite(LED_BUILTIN, HIGH);
//
delay(1000);
// wait for
digitalWrite(LED_BUILTIN, LOW);
//
delay(1000);
// wait for
}

again forever
turn the LED on (HIGH is the voltage level)
a second
turn the LED off by making the voltage LOW
a second

Note that we use LED_BUILTIN not pin 13 for the LED pin. That's because we
don't always use pin 13 for the LED on boards. For example, on the Metro ESP32S2 the LED is on pin 42!
And click upload! After uploading, you may see something like this:

And click upload! After uploading, you may
see something like this, warning you that
we could not get out of reset.
This is normal! Press the RESET button on
your board to launch the sketch

That's it, you will be able to see the red LED blink. You will also see a new serial port
created.
You may call Serial.begin(); in your sketch to create the serial port so don't
forget it, it is not required for other Arduinos or previous ESP boards!

You can now select the new serial port name which will be different than the
bootloader serial port. Arduino IDE will try to use auto-reset to automatically put the
board into bootloader mode when you ask it to upload new code
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If you ever DON'T see a serial port, or something is not working out with upload you
can always manually enter bootloader mode:
• Reset board into ROM bootloader with DFU/BOOT0 + Reset buttons
• Select the ESP32S2/S3 Dev Board ROM bootloader serial port in Tools->Port
menu
• Upload sketch
• Click reset button to launch code

WiFi Test
Thanksfully if you have ESP32 sketches, they'll 'just work' with variations of ESP32.
You can find a wide range of examples in the File->Examples->Examples for Adafruit
Metro ESP32-S2 subheading (the name of the board may vary so it could be "Example
s for Adafruit Feather ESP32 V2" etc)

Let's start by scanning the local networks.
Load up the WiFiScan example under Examples->Examples for YOUR BOARDNAME>WiFi->WiFiScan
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And upload this example to your board. The ESP32 should scan and find WiFi
networks around you.
For ESP32, open the serial monitor, to see the scan begin.
For ESP32-S2, -S3 and -C3, don't forget you have to click Reset after uploading
through the ROM bootloader. Then select the new USB Serial port created by the
ESP32. It will take a few seconds for the board to complete the scan.

If you can not scan any networks, check your power supply. You need a solid power
supply in order for the ESP32 to not brown out. A skinny USB cable or drained battery
can cause issues.
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WiFi Connection Test
Now that you can scan networks around you, its time to connect to the Internet!
Copy the example below and paste it into the Arduino IDE:
// SPDX-FileCopyrightText: 2020 Brent Rubell for Adafruit Industries
//
// SPDX-License-Identifier: MIT
/*
Web client
This sketch connects to a website (wifitest.adafruit.com/testwifi/index.html)
using the WiFi module.
This example is written for a network using WPA encryption. For
WEP or WPA, change the Wifi.begin() call accordingly.
This example is written for a network using WPA encryption. For
WEP or WPA, change the Wifi.begin() call accordingly.
created 13 July 2010
by dlf (Metodo2 srl)
modified 31 May 2012
by Tom Igoe
*/
#include <WiFi.h>
// Enter your WiFi SSID and password
char ssid[] = "YOUR_SSID";
char pass[] = "YOUR_SSID_PASSWORD";
use as key for WEP)
int keyIndex = 0;
only for WEP)

// your network SSID (name)
// your network password (use for WPA, or
// your network key Index number (needed

int status = WL_IDLE_STATUS;
// if you don't want to use DNS (and reduce your sketch size)
// use the numeric IP instead of the name for the server:
//IPAddress server(74,125,232,128); // numeric IP for Google (no DNS)
char server[] = "wifitest.adafruit.com";
char path[]
= "/testwifi/index.html";

// name address for adafruit test

// Initialize the Ethernet client library
// with the IP address and port of the server
// that you want to connect to (port 80 is default for HTTP):
WiFiClient client;
void setup() {
//Initialize serial and wait for port to open:
Serial.begin(115200);
while (!Serial) {
; // wait for serial port to connect. Needed for native USB port only
}
// attempt to connect to Wifi network:
Serial.print("Attempting to connect to SSID: ");
Serial.println(ssid);
WiFi.begin(ssid, pass);
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while (WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");
}
Serial.println("");
Serial.println("Connected to WiFi");
printWifiStatus();
Serial.println("\nStarting connection to server...");
// if you get a connection, report back via serial:
if (client.connect(server, 80)) {
Serial.println("connected to server");
// Make a HTTP request:
client.print("GET "); client.print(path); client.println(" HTTP/1.1");
client.print("Host: "); client.println(server);
client.println("Connection: close");
client.println();
}
}
void loop() {
// if there are incoming bytes available
// from the server, read them and print them:
while (client.available()) {
char c = client.read();
Serial.write(c);
}
// if the server's disconnected, stop the client:
if (!client.connected()) {
Serial.println();
Serial.println("disconnecting from server.");
client.stop();
// do nothing forevermore:
while (true) {
delay(100);
}
}
}
void printWifiStatus() {
// print the SSID of the network you're attached to:
Serial.print("SSID: ");
Serial.println(WiFi.SSID());
// print your board's IP address:
IPAddress ip = WiFi.localIP();
Serial.print("IP Address: ");
Serial.println(ip);
// print the received signal strength:
long rssi = WiFi.RSSI();
Serial.print("signal strength (RSSI):");
Serial.print(rssi);
Serial.println(" dBm");
}

NOTE: You must change the SECRET_SSID and SECRET_PASS in the example code
to your WiFi SSID and password before uploading this to your board.
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After you've set it correctly, upload and check the serial monitor. You should see the
following. If not, go back, check wiring, power and your SSID/password

Secure Connection Example
Many servers today do not allow non-SSL connectivity. Lucky for you the ESP32 has a
great TLS/SSL stack so you can have that all taken care of for you. Here's an example
of a using a secure WiFi connection to connect to the Twitter API.
Copy and paste it into the Arduino IDE:
// SPDX-FileCopyrightText: 2015 Arturo Guadalupi
// SPDX-FileCopyrightText: 2020 Brent Rubell for Adafruit Industries
//
// SPDX-License-Identifier: MIT
/*
This example creates a client object that connects and transfers
data using always SSL.
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It is compatible with the methods normally related to plain
connections, like client.connect(host, port).
Written by Arturo Guadalupi
last revision November 2015
*/
#include <WiFiClientSecure.h>
// Enter your WiFi SSID and password
char ssid[] = "YOUR_SSID";
char pass[] = "YOUR_SSID_PASSWORD";
use as key for WEP)
int keyIndex = 0;
only for WEP)

// your network SSID (name)
// your network password (use for WPA, or
// your network key Index number (needed

int status = WL_IDLE_STATUS;
// if you don't want to use DNS (and reduce your sketch size)
// use the numeric IP instead of the name for the server:
//IPAddress server(74,125,232,128); // numeric IP for Google (no DNS)
#define SERVER "cdn.syndication.twimg.com"
#define PATH
"/widgets/followbutton/info.json?screen_names=adafruit"
// Initialize the SSL client library
// with the IP address and port of the server
// that you want to connect to (port 443 is default for HTTPS):
WiFiClientSecure client;
void setup() {
//Initialize serial and wait for port to open:
Serial.begin(115200);
while (!Serial) {
; // wait for serial port to connect. Needed for native USB port only
}
// attempt to connect to Wifi network:
Serial.print("Attempting to connect to SSID: ");
Serial.println(ssid);
WiFi.begin(ssid, pass);
while (WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");
}
Serial.println("");
Serial.println("Connected to WiFi");
printWifiStatus();
client.setInsecure(); // don't use a root cert
Serial.println("\nStarting connection to server...");
// if you get a connection, report back via serial:
if (client.connect(SERVER, 443)) {
Serial.println("connected to server");
// Make a HTTP request:
client.println("GET " PATH " HTTP/1.1");
client.println("Host: " SERVER);
client.println("Connection: close");
client.println();
}
}
uint32_t bytes = 0;
void loop() {
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// if there are incoming bytes available
// from the server, read them and print them:
while (client.available()) {
char c = client.read();
Serial.write(c);
bytes++;
}
// if the server's disconnected, stop the client:
if (!client.connected()) {
Serial.println();
Serial.println("disconnecting from server.");
client.stop();
Serial.print("Read "); Serial.print(bytes); Serial.println(" bytes");
// do nothing forevermore:
while (true);
}
}
void printWifiStatus() {
// print the SSID of the network you're attached to:
Serial.print("SSID: ");
Serial.println(WiFi.SSID());
// print your board's IP address:
IPAddress ip = WiFi.localIP();
Serial.print("IP Address: ");
Serial.println(ip);
// print the received signal strength:
long rssi = WiFi.RSSI();
Serial.print("signal strength (RSSI):");
Serial.print(rssi);
Serial.println(" dBm");
}

As before, update the ssid and password first, then upload the example to your board.
Note we use WiFiClientSecure client instead of WiFiClient client; to
require a SSL connection! This example will connect to a twitter server to download a
JSON snippet that says how many followers adafruit has
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JSON Parsing Demo
This example is a little more advanced - many sites will have API's that give you JSON
data. We will build on the previous SSL example to connect to twitter and get that
JSON data chunk
Then we'll use ArduinoJSON () to convert that to a format we can use and then
display that data on the serial port (which can then be re-directed to a display of some
sort)
First up, use the Library manager to install ArduinoJSON ().
Then load the example JSONdemo by copying the code below and pasting it into
your Arduino IDE.
//
//
//
//
//

SPDX-FileCopyrightText: 2014 Benoit Blanchon
SPDX-FileCopyrightText: 2014 Arturo Guadalupi
SPDX-FileCopyrightText: 2020 Brent Rubell for Adafruit Industries
SPDX-License-Identifier: MIT

/*
This example creates a client object that connects and transfers
data using always SSL, then shows how to parse a JSON document in an HTTP response.
It is compatible with the methods normally related to plain
connections, like client.connect(host, port).
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Written by Arturo Guadalupi + Copyright Benoit Blanchon 2014-2019
last revision November 2015
*/
#include <WiFiClientSecure.h>
#include <ArduinoJson.h>
#include <Wire.h>
// uncomment the next line if you have a 128x32 OLED on the I2C pins
//#define USE_OLED
// uncomment the next line to deep sleep between requests
//#define USE_DEEPSLEEP
#if defined(USE_OLED)
// Some boards have TWO I2C ports, how nifty. We should use the second one sometimes
#if defined(ARDUINO_ADAFRUIT_QTPY_ESP32S2) || \
defined(ARDUINO_ADAFRUIT_QTPY_ESP32S3_NOPSRAM) || \
defined(ARDUINO_ADAFRUIT_QTPY_ESP32_PICO)
#define OLED_I2C_PORT &Wire1
#else
#define OLED_I2C_PORT &Wire
#endif
#include <Adafruit_SSD1306.h>
Adafruit_SSD1306 display = Adafruit_SSD1306(128, 32, OLED_I2C_PORT);
#endif
// Enter your WiFi SSID and password
char ssid[] = "YOUR_SSID";
char pass[] = "YOUR_SSID_PASSWORD";
use as key for WEP)
int keyIndex = 0;
only for WEP)

// your network SSID (name)
// your network password (use for WPA, or
// your network key Index number (needed

int status = WL_IDLE_STATUS;
// if you don't want to use DNS (and reduce your sketch size)
// use the numeric IP instead of the name for the server:
//IPAddress server(74,125,232,128); // numeric IP for Google (no DNS)
#define SERVER "cdn.syndication.twimg.com"
#define PATH
"/widgets/followbutton/info.json?screen_names=adafruit"
void setup() {
//Initialize serial and wait for port to open:
Serial.begin(115200);
// Connect to WPA/WPA2 network
WiFi.begin(ssid, pass);
#if defined(USE_OLED)
setupI2C();
delay(200); // wait for OLED to reset
if(!display.begin(SSD1306_SWITCHCAPVCC, 0x3C)) { // Address 0x3C for 128x32
Serial.println(F("SSD1306 allocation failed"));
for(;;); // Don't proceed, loop forever
}
display.display();
display.setTextSize(1);
display.setTextColor(WHITE);
display.clearDisplay();
display.setCursor(0,0);
#else
// Don't wait for serial if we have an OLED
while (!Serial) {
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// wait for serial port to connect. Needed for native USB port only
delay(10);
}
#endif
// attempt to connect to Wifi network:
Serial.print("Attempting to connect to SSID: ");
Serial.println(ssid);
#if defined(USE_OLED)
display.clearDisplay(); display.setCursor(0,0);
display.print("Connecting to SSID\n"); display.println(ssid);
display.display();
#endif
while (WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");
}
Serial.println("");
Serial.println("Connected to WiFi");
#if defined(USE_OLED)
display.print("...OK!");
display.display();
#endif
printWifiStatus();
}
uint32_t bytes = 0;
void loop() {
WiFiClientSecure client;
client.setInsecure(); // don't use a root cert
Serial.println("\nStarting connection to server...");
#if defined(USE_OLED)
display.clearDisplay(); display.setCursor(0,0);
display.print("Connecting to "); display.print(SERVER);
display.display();
#endif
// if you get a connection, report back via serial:
if (client.connect(SERVER, 443)) {
Serial.println("connected to server");
// Make a HTTP request:
client.println("GET " PATH " HTTP/1.1");
client.println("Host: " SERVER);
client.println("Connection: close");
client.println();
}
// Check HTTP status
char status[32] = {0};
client.readBytesUntil('\r', status, sizeof(status));
if (strcmp(status, "HTTP/1.1 200 OK") != 0) {
Serial.print(F("Unexpected response: "));
Serial.println(status);
#if defined(USE_OLED)
display.print("Connection failed, code: "); display.println(status);
display.display();
#endif
return;
}
// wait until we get a double blank line
client.find("\r\n\r\n", 4);
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// Allocate the JSON document
// Use arduinojson.org/v6/assistant to compute the capacity.
const size_t capacity = JSON_ARRAY_SIZE(1) + JSON_OBJECT_SIZE(8) + 200;
DynamicJsonDocument doc(capacity);
// Parse JSON object
DeserializationError error = deserializeJson(doc, client);
if (error) {
Serial.print(F("deserializeJson() failed: "));
Serial.println(error.c_str());
return;
}
// Extract values
JsonObject root_0 = doc[0];
Serial.println(F("Response:"));
const char* root_0_screen_name = root_0["screen_name"];
long root_0_followers_count = root_0["followers_count"];
Serial.print("Twitter username: "); Serial.println(root_0_screen_name);
Serial.print("Twitter followers: "); Serial.println(root_0_followers_count);
#if defined(USE_OLED)
display.clearDisplay(); display.setCursor(0,0);
display.setTextSize(2);
display.println(root_0_screen_name);
display.println(root_0_followers_count);
display.display();
display.setTextSize(1);
#endif
// Disconnect
client.stop();
delay(1000);
#if defined(USE_DEEPSLEEP)
#if defined(USE_OLED)
display.clearDisplay();
display.display();
#endif // OLED
#if defined(NEOPIXEL_POWER)
digitalWrite(NEOPIXEL_POWER, LOW); // off
#elif defined(NEOPIXEL_I2C_POWER)
digitalWrite(NEOPIXEL_I2C_POWER, LOW); // off
#endif
// wake up 1 second later and then go into deep sleep
esp_sleep_enable_timer_wakeup(10 * 1000UL * 1000UL); // 10 sec
esp_deep_sleep_start();
#else
delay(10 * 1000);
#endif
}
void setupI2C() {
#if defined(ARDUINO_ADAFRUIT_QTPY_ESP32S2) || \
defined(ARDUINO_ADAFRUIT_QTPY_ESP32S3_NOPSRAM) || \
defined(ARDUINO_ADAFRUIT_QTPY_ESP32_PICO)
// ESP32 is kinda odd in that secondary ports must be manually
// assigned their pins with setPins()!
Wire1.setPins(SDA1, SCL1);
#endif
#if defined(NEOPIXEL_I2C_POWER)
pinMode(NEOPIXEL_I2C_POWER, OUTPUT);
digitalWrite(NEOPIXEL_I2C_POWER, HIGH); // on
#endif
#if defined(ARDUINO_ADAFRUIT_FEATHER_ESP32S2)
// turn on the I2C power by setting pin to opposite of 'rest state'
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pinMode(PIN_I2C_POWER, INPUT);
delay(1);
bool polarity = digitalRead(PIN_I2C_POWER);
pinMode(PIN_I2C_POWER, OUTPUT);
digitalWrite(PIN_I2C_POWER, !polarity);
#endif
}
void printWifiStatus() {
// print the SSID of the network you're attached to:
Serial.print("SSID: ");
Serial.println(WiFi.SSID());
// print your board's IP address:
IPAddress ip = WiFi.localIP();
Serial.print("IP Address: ");
Serial.println(ip);
// print the received signal strength:
long rssi = WiFi.RSSI();
Serial.print("signal strength (RSSI):");
Serial.print(rssi);
Serial.println(" dBm");
}

By default it will connect to to the Twitter banner image API, parse the username and
followers, and display them.

Usage with Adafruit IO
The ESP32-S2/S3 is an affordable, all-in-one, option for connecting your projects to
the internet using our IoT platform, Adafruit IO ().
• For more information and guides about Adafruit IO, check out the Adafruit IO
Basics Series. ()
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Install Libraries
In the Arduino IDE, navigate to Sketch -> Include Library->Manage Libraries...

Enter Adafruit IO Arduino into the search box, and click Install on the Adafruit IO
Arduino library option to install version 4.0.0 or higher.

When asked to install dependencies, click Install all.
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Adafruit IO Setup
If you do not already have an Adafruit IO account, create one now (). Next, navigate to
the Adafruit IO Dashboards page.
We'll create a dashboard to visualize and interact with the data being sent between
your ESP32-S2/S3 board and Adafruit IO.

Click the New Dashboard button.
Name your dashboard My ESP32-S2 or My
ESP32-S3 depending on your board.
Your new dashboard should appear in the
list.
Click the link to be brought to your new
dashboard.
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We'll want to turn the board's LED on or off from Adafruit IO. To do this, we'll need to
add a toggle button to our dashboard.

Click the cog at the top right hand corner
of your dashboard.
In the dashboard settings dropdown, click
Create New Block.
Select the toggle block.
Under My Feeds, enter led as a feed
name. Click Create.
Choose the led feed to connect it to the
toggle block. Click Next step.
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Under Block Settings,
Change Button On Text to 1
Change Button Off Text to 0
Click Create block

Next up, we'll want to display button press data from your board on Adafruit IO. To do
this, we'll add a gauge block to the Adafruit IO dashboard. A gauge is a read only
block type that shows a fixed range of values.
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Click the cog at the top right hand corner
of your dashboard.
In the dashboard settings dropdown, click
Create New Block.
Select the gauge block.
Under My Feeds, enter button as a feed
name.
Click Create.
Choose the button feed to connect it to
the toggle block.
Click Next step.
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Under block settings,
Change Block Title to Button Value
Change Gauge Min Value to 0, the
button's state when it's off
Change Gauge Max Value to 1, the button's
state when it's on
Click Create block

Your dashboard should look like the following:

Code Usage
For this example, you will need to open the adafruitio_26_led_btn example included
with the Adafruit IO Arduino library. In the Arduino IDE, navigate to File -> Examples ->
Adafruit IO Arduino -> adafruitio_26_led_btn.
Before uploading this code to the ESP32-S2/S3, you'll need to add your network and
Adafruit IO credentials. Click on the config.h tab in the sketch.
Obtain your Adafruit IO Credentials from navigating to io.adafruit.com and clicking My
Key (). Copy and paste these credentials next to IO_USERNAME and IO_KEY .
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Enter your network credentials next to WIFI_SSID and WIFI_PASS .

Click the Upload button to upload your sketch to the ESP32-S2/S3. After uploading, pr
ess the RESET button on your board to launch the sketch.
Open the Arduino Serial monitor and navigate to the Adafruit IO dashboard you
created. You should see the gauge response to button press and the board's LED
light up in response to the Toggle Switch block.

You should also see the ESP32-S2/S3's LED turning on and off when the LED is
toggled:
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Debugging with OpenOCD
It is possible to use a true step-andmemory debugger using OpenOCD - you
will need an external debugger like a JLink
or FT2232 JTAG adapter

You can use an OpenOCD compatible debugging probe such as J-Link for source
level debugging of C and C++ code on the Adafruit Metro ESP32-S2. (However, I had
more luck with a J-link BASE than a J-Link EDU Mini and more consistent behavior
with the built in debugger of the Kaluga devkit than either)
SEGGER J-Link EDU Mini - JTAG/SWD
Debugger
Doing some serious development on any
ARM-based platform, and tired of 'printf'
plus an LED to debug? A proper JTAG/
SWD HW debugger can make debugging
more of a pleasure and...
https://www.adafruit.com/product/3571
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Metro ESP32S2
First you'll need to solder on an SWD connector at the indicated location on the Metro
ESP32-S2 PCB. Note that the "key" of the box header must be on the same side as
the "pin 1" arrow. These are very fine pitch headers and can be difficult to solder. Any
solder bridges between the pins will prevent the connection from working.
SWD 0.05" Pitch Connector - 10 Pin SMT
Box Header
This 1.27mm pitch, 2x5 male SMT Box
Header is the same one used on our SWD
Cable Breakout Board. The header...
https://www.adafruit.com/product/752

Mini SWD 0.05" Pitch Connector - 10 Pin
SMT Box Header
We've carrying a new 1.27mm pitch
2x5 Mini SWD 0.05" Pitch Connector. It's a
tinier, bite-sized version of the
https://www.adafruit.com/product/4048

OpenOCD Setup
Next, you'll need the version of the Open On-Chip Debugger (OpenOCD) updated
with ESP32-S2 support by Espressif. If you have a CircuitPython build environment
available, just use the export.sh from your CircuitPython source directory. Otherwise,
you'll want to follow the official installation instructions () from Espressif.
Verify that you have Espressif's version of OpenOCD--just look for "esp32" in the
version number, and make sure the date is at least as new as this one:
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$ openocd --version
Open On-Chip Debugger v0.10.0-esp32-20200709 (2020-07-09-08:54)

You also need the correct debugger program, xtensa-esp32s2-elf-gdb , this
version or newer:
$ xtensa-esp32s2-elf-gdb --version
GNU gdb (crosstool-NG esp-2020r3) 8.1.0.20180627-git

In one terminal, start OpenOCD:
openocd -f 'interface/jlink.cfg' -f 'target/esp32s2.cfg' -c
'adapter_khz 2000'

In another terminal, start gdb and connect to OpenOCD:
$ xtensa-esp32s2-elf-gdb build-adafruit_metro_esp32s2/firmware.elf
(gdb) target remote :3333
Remote debugging using :3333
0x4001b800 in ?? ()
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I have not had success programming the chip using gdb commands like load or
OpenOCD commands like program_esp . It's inconvenient but I still use esptool
when reprogramming the chip.

Downloads
Files:
• ESP32-S2 product page with resources ()
• ESP32-S2 datasheet ()
• ESP32-S2 WROVER datasheet ()
• ESP32-S2 Technical Reference ()
• EagleCAD files on GitHub ()
• 3D Models on GitHub ()
• Fritzing object in the Adafruit Fritzing Library ()
• PDF for Metro ESP32-S2 PrettyPins Diagram ()

SVG for Metro ESP32-S2 PrettyPins
Diagram
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Schematic and Fab Print
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